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Preface
This 3+ Open MS-DOS LAN Manager User Reference describes individual
commands and operations for both the Basic and Enhanced versions.
You should refer to this manual for help with specific tasks if you are using a
netstation with 3+Open MS-DOS LAN Manager. A netstation is a computer linked
to a local area network, using network resources but not offering its own resources
to other computers.
This introduction explains how to use this reference. It also gives an ovelView of
other manuals you can turn to for help in using MS-DOS LAN Manager.

Before You Begin

Before using this reference, you should read the 3 +Open MS-DOS IAN Manager
User Guide. This manual teaches you how to use MS-DOS LAN Manager and
explains concepts, procedures, and terms not reviewed here. In addition to reading
the manual, you should also:
•

Feel comfortable using the MS-DOS or PC-DOS operating systems.

•

Be able to create and work with files and directories.

•

Have MS-DOS LAN Manager installed on your computer (see your system
administrator if you have questions about this).

•

Know if you are using the Basic or Enhanced version of MS-DOS LAN
Manager.

•

Be comfortable either typing MS-DOS LAN Manager commands at the
MS-DOS prompt or, if you are using MS-DOS LAN Manager Enhanced,
using the LAN Manager screen.

For information about the differences between Basic and Enhanced MS-DOS LAN
Manager, see Chapter 1: About MS-DOS LAN Manager.

Contents of This Reference
The following list explains the chapters in this reference.
Chapter

Contents

Chapter 1:
AbOut MS-DOS
LAN Manager

Features of MS-DOS LAN Manacfer and the
differences between the Basic an Enhanced
versions. This chapter also briefly explains how to
start and use 3+Open MS-DOS LAN Manager and
how to get help.
MS-DOS LAN Manager commands you can type
at the MS-DOS prompt. The flrst section in this
chapter explains Basic commands, which can be
used with either Basic or Enhanced MS-DOS LAN
Manager; the second section explains commands
only available with the Enhanced version. The
commands are listed alphabetically by section.
LAN Manager screen, its menus, and dialog
boxes. The reference is arranged in the order of the
menus as they appear across the menu bar. The
dialog boxes are presented in hierarchical order
after their menus.
MS-DOS LAN Manager error messages and
comments that m~ appear at the MS-DOS
prompt or in LA Manager screen message boxes.

Cha!I5er 2:
MS- OS LAN Manager
Command Reference

Chapter 3:
LAN Manager Screen
Reference

Appendix A:
Error Messages
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Notational Conventions
As you read this reference, keep in mind the following conventions to help you
distinguish different types of text:

Text Element

Indicates

ALL CAPITAL LETTERS

Command names and filenames.

Bold

New terms.
Input you enter.
Screen text.

Bold Courier typeface
Regular Courier typeface

[Brackets]

Nonalihabetic key names, such as
[Enter , or command options.

Italics

Variable command option names.

Notational Convention Examples
To show you how different types of text in this reference help you perform tasks
with MS-DOS LAN Manager, this section gives you examples of usage with both
MS-DOS LAN Manager commands and the LAN Manager screen.

Text Examples with Commands
MS-DOS LAN Manager commands are typed at the MS-DOS prompt. (The syntax
for each command is detailed in Chapter 2: MS-DOS LAN Manager Command
Reference.) The syntax defmitions in Chapter 2 include "bubble" diagrams which
give you a definitive roadmap to follow to use each command and its options
correctly.

xvi

Text Examples with the LAN Manager Screen
From the LAN Manager screen, you peiform tasks by selecting menus and menu
items, which take you to dialog boxes. Dialog boxes have command buttons, text
fields, and other features that let you accomplish a task easily.
To reach a dialog box, you must follow an access path, which begins with a menu
and moves through a menu item to the dialog box. Arrows are used to show the
progression through an access path. For example, the Use a Network Resource
dialog box is reached through the View menu. Its access path is shown as:
View->This workstation->Add use

Each dialog box reference page in Chapter 3: LAN Manager Screen Reference
shows the access path needed to reach the dialog box.

Procedural Conventions
Information you should enter is shown in blue. Terms shown in italics should be
replaced with specific information. For example:
logon

username

password~

means that you type the command LOOON exactly as shown, and substitute
specific information for the general terms shown in italics. In this example, you
would substitute your own user name where the line shows the word username,
and your own password where the line shows password. Press [Enter] at the end
of the command.

xvii

Finding Further Information
In addition to this manual, the following manual is included with MS-DOS LAN
Manager:
•

3 +Open MS-DOS LAN Manager User Guide, a procedural guide for using
MS-DOS LAN Manager on a netstation. This manual provides you with
tutorials and instructions for MS-DOS LAN Manager tasks.

xviii
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Chapter 1: About MS-DOS LAN Manager
3+Open MS-DOS LAN Manager lets you link your computer to a local area
network and use shared resources such as disk drives and printers. Two versions
of MS-DOS LAN Manager are available: Basic and Enhanced. Each is explained
in this reference.
The capabilities of the Basic and Enhanced versions are reflected in their names.
MS-DOS LAN Manager Basic lets you use shared resources by typing commands
at the MS-DOS prompt. MS-DOS LAN Manager Enhanced does everything Basic
does and more-it includes commands not found in the Basic version, and also lets
you work with menus and dialog boxes at the LAN Manager screen instead of
typing commands. MS-DOS LAN Manager Enhanced lets you send and receive
messages, and automatically connect to several shared resources at once.

1
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MS-DOS LAN Manager Basic
With MS-DOS LAN Manager Basic, you can:
•

Keep your workgroup's data in a secure and centralized location.

•

Add your personal computer to an existing MS-DOS or OS/2™ network.

•

Read, revise, and create files on other computers.

•

Use applications-such as Microsoft Word-with files on other computers.

•

Use resources-like disks or printers-attached to servers.

•

Display printer queues.

•

Get on-line help.

MS-DOS LAN Manager Enhanced
With the advanced version of MS-DOS LAN Manager----called MS-DOS LAN
Manager Enhanced-you can choose between typing commands at the MS-DOS
prompt and using a full-screen interface. MS-DOS LAN Manager Enhanced gives
you access to all of the features of MS-DOS LAN Manager Basic, plus several
others. You can:
•

Work with menus and dialog boxes on the LAN Manager screen instead of
typing commands.

•

Send and receive messages across the local area network with the Messenger
and Netpopup services.

•

Put together a customized set of connections----called a profile-so that you can
connect to a number of frequently used resources with one command.

•

Move and copy files from one place to another on the local area network.

About MS-DOS
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Startup and Security
Regardless of whether you are using the Basic or the Enhanced version, the fIrst
step in using MS-DOS LAN Manager is to start the software on your computer. To
do this, you need to start the Workstation service, which links your computer to the
local area network as a netstation. The 3+Open MS-DOS LAN Manager setup
program puts the following line in your AUTOEXEC.BAT startup flie to perform
startup:
net start workstation

You may also start the Workstation service by typing this command at the MS-DOS
prompt. This command identifIes your computer to the local area network so that
you can perform networking tasks using either MS-DOS LAN Manager commands
or, if you have the Enhanced version, the LAN Manager screen. See also Chapter
5: Startup and Security in the 3 + Open MS-DOS LAN Manager User Guide for a
discussion of starting MS-DOS LAN Manager and commands you can include in
AUTOEXEC.BAT.
If you are using MS-DOS LAN Manager Enhanced, you can also start two other
services on your netstation: the Messenger service and the Netpopup service. For
more information about these services, see the NET START MESSENGER and
NET START NETPOPUP command reference pages in Chapter 2: MS-DOS LAN
Manager Command Reference.

Logging On to the Local Area Network
Once you have identifIed your computer to the local area network, the next step is to
identify yourself. To do this, you must log on using your user name and logon
password. The NETSETUP program installed the necessary commands in your
netstation's AUTOEXEC.BAT file, so that logging on will be performed
automatically each time you start your netstation.

1
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For example, Mary Sullivan's user name is marys, and her logon password is
wanderer. Her netstation's AUTOEXEC.BAT fue contains the following
command to log on to the local area network:
logon marys wanderer

Once you start the Workstation service and log on to the local area network, you are
ready to use local area network resources and perfonn other tasks with MS-DOS
LAN Manager.
If your password or user name change, you can edit the LOGON line in your
AUTOEXEC.BAT fue accordingly. Refer to the LOGON command in Chapter 2:
MS-DOS LAN Manager Command Reference for more infonnation.

Automatic Startup
MS-DOS LAN Manager perfonns some logon tasks for you automatically. For
instance, when you request use of a server, MS-DOS LAN Manager remembers
your user name and password, and automatically sends them along for verification
before logging you on to the server. See Chapter 2: MS-DOS LAN Manager
Command Reference and Chapter 3: LAN Manager Screen Reference for more
details on logging on.

Using MS-DOS LAN Manager
Once you have started the Workstation service, you are ready to perfonn local area
network tasks. If you are using MS-DOS LAN Manager Enhanced, there are two
ways to perfonn tasks:
•

By typing MS-DOS LAN Manager commands at the MS-DOS prompt.

•

By selecting options from menus and dialog boxes on the LAN Manager
screen.
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MS-DOS LAN Manager Commands
If you are using MS-DOS LAN Manager Basic, typing commands at the MS-DOS
prompt is the only way you can use the system. Even if you have the Enhanced
version, you may prefer to type commands instead of using the menus and dialog
boxes on the LAN Manager screen. It can be the quicker alternative if you are well
acquainted with the commands and their options, and it lets you perform certain
tasks-such as moving files-that cannot be done with the LAN Manager screen.

You can use many commands regardless of whether you have the Basic or the
Enhanced version of MS-DOS LAN Manager. However, some commands are only
available with the Enhanced version. For more information about MS-DOS LAN
Manager commands and how to use them, see Chapter 2: MS-DOS LAN Manager
Command Reference. The chapter is divided into an introduction and two sections.
The fIrst section explains Basic commands, which are available to all users, and the
second section explains Enhanced commands.
See also the 3+0pen MS-DOS LAN Manager User Guide for more information
about performing local area network tasks using MS-DOS LAN Manager
commands. If you are already familiar with the 3Com 3+ system, you will notice
that many MS-DOS LAN Manager commands are similar.
To automate local area network tasks, you can place MS-DOS LAN Manager
commands in batch files, such as your AUTOEXEC.BAT file.

LAN Manager Screen
The LAN Manager screen is a windowed user interface that organizes MS-DOS
LAN Manager commands into a system of menus. It is available only to users with
MS-DOS LAN Manager Enhanced.
Menus and dialog boxes provide you with various options from which you can
choose without having to remember specific commands. Many people fmd that
performing tasks using the LAN Manager screen is easier and more convenient than
typing commands. For more information about using the LAN Manager screen,
see the 3+0pen MS-DOS LAN Manager User Guide.
For more information about menus and dialog boxes contained within the LAN
Manager screen, see Chapter 3: LAN Manager Screen Reference.

1
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Getting More Information
MS-DOS LAN Manager provides more information when you need it by displaying
information or error messages and providing on-line help for both MS-DOS LAN
Manager commands and the LAN Manager screen.

On-Line Help
Whether you are performing local area network tasks using MS-DOS LAN
Manager commands or the LAN Manager screen, you can get additional
information to help you as you work.

The NET HELP Command
MS-DOS LAN Manager provides a special help command to assist you in using
MS-DOS LAN Manager commands (commands you type at the MS-DOS prompt or
use in a batch fue). To get information about using a particular MS-DOS LAN
Manager command, type NET HELP, followed by the command name. If the
command begins with the word NET, type NET HELP followed only by the
second word of the command. For example, if you want more information about
using the NET USE command, type:
net

help

use

MS-DOS LAN Manager displays the following information:
The syntax of this command is:
NET USE [devicename I \ \computername\ sharename]
NET USE [devicename] \\computername\sharename [password]
NET USE {devicename I \\computername\sharename} /DELETE
The NET USE command connects a netstation's local devicename to a
server's shared resource.
See the MS-DOS LAN Manager User Reference for more information
about this command.
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You can also type NET HELP by itself. The following list appears to show you
more about the help command:
The syntax of this command is:
NET HELP [topic]
Help is available on:
NET
Help on the following NET commands is available:
ACCESS
HELP
MOVE
PRINT
USE VIEW

CONTINUE
LOAD
PASSWORD
SEND

COpy
LOGOFF
LOGON
START

Help is also available on these special topics:
NAMES

SYNTAX

Help With the LAN Manager Screen
If you are using MS-DOS LAN Manager Enhanced and you are working in the
LAN Manager screen, you can press [FI] to get context-sensitive help.

This means, for example, that if you are working in the Use a Network Resource
dialog box and press [FI], information is displayed about using that particular
dialog box. This information is accompanied by an index from which you can
choose topics of interest to you, including general information about how to use
menus and dialog boxes.

1
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Error Messages
If you type an MS-DOS LAN Manager command with an option that MS-DOS
LAN Manager does not recognize, you will see an error message in this form:
NETiiii: Message text.
#### is a four-digit number that uniquely identifies the MS-DOS LAN Manager

message. Message text is a short message that describes the error. For a complete
listing of MS-DOS LAN Manager error messages that may appear at the MS-DOS
prompt, see Appendix A: Error Messages.
When you are working in the LAN Manager screen, messages are displayed by
message boxes. Some of the messages displayed are the same as those displayed at
the MS-DOS prompt. Other messages displayed are specific to the LAN Manager
screen. To get more infonnation about a message displayed by the LAN Manager
screen, press [FI].
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Chapter 2: MS-DOS LAN Manager
Command Reference
3+0pen MS-DOS LAN Manager lets you perform LAN Manager operations by
typing commands at the MS-DOS prompt. If you are using MS-DOS LAN
Manager Basic, this is the only way you can operate the system.
If you have the Enhanced version of MS-DOS LAN Manager, you can perform
most of the same operations using the LAN Manager screen, described in Chapter
3: LAN Manager Screen Reference. The option of typing MS-DOS LAN Manager
commands is useful if:

•

You are familiar with the 3Com 3+ command-line interfaces.

•

You are an expert user who feels more comfortable typing commands than
using menus in a full-screen interface (LAN Manager screen).

•

You want to add MS-DOS LAN Manager commands to batch files.

2
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How to Use This Chapter
This chapter is divided into three major sections:
•

"Using MS-DOS LAN Manger Commands" provides general information about
how to use all MS-DOS LAN Manager commands. You should read this
section regardless of whether you use MS-DOS LAN Manager Basic or
MS-DOS LAN Manager Enhanced.

•

"Basic Commands" describes the commands that are part of MS-DOS LAN
Manager Basic. Users of the Enhanced version will also use this section,
because MS-DOS LAN Manager Enhanced includes all the Basic commands.

•

"Enhanced Commands" describes the commands which are part of MS-DOS
LAN Manager Enhanced, in addition to the commands included in Basic. Only
users of the Enhanced version need to use this section.

The command reference sections each begin with a table of the commands
applicable to the version of MS-DOS LAN Manager discussed in that section.
Commands are listed alphabetically within each section; each command reference
explains the usage, syntax, and available options for the command.
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Using MS-DOS LAN Manager Commands
You should know a few rules and guidelines to help you best use the MS-DOS
LAN Manager commands described in this chapter.
This section describes abbreviations you can use in some commands, and shows
how to use passwords. Commands that depend on others-for example,
commands that must be run before other commands-are described, along with
prompts that will help you remember these dependencies. MS-DOS LAN Manager
commands may be used in batch files; this section provides some useful guidance
for doing so.

Abbreviations
You may use abbreviations when typing MS-DOS LAN Manager commands.
Although the command reference pages in this chapter spell out all command
names, option names, and service names, MS-DOS LAN Manager allows you to
abbreviate many of these for your convenience.

Service Names
MS-DOS LAN Manager allows you to use abbreviations and synonyms for the
following MS-DOS LAN Manager services:

Service

Abbreviations, synonyms

Workstation

wksta, work, redirector, redir, rdr

Messenger

msg, receiver, rcv

2
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Option Names
MS-DOS LAN Manager also allows you to type any unambiguous abbreviation for
a command option. This means you must type enough letters in the option's name
to distinguish the option you choose from other options for that command.
For example, if you are using a command whose possible options are Iread and

Isend, you may type Ir instead of Ire ad, and Is instead of Isend. However, if the
command's options were Iread and Iredo, MS-DOS LAN Manager would not
accept /r, but would accept either Irea for Iread, or Ired for Iredo.
The command reference pages in this chapter list command options in alphabetical
order, making it easier for you to compare similar option names.

Commands That Start Services Automatically
Some MS-DOS LAN Manager commands will not work unless you have started a
service or performed another command flrst. For example, you must start the
Workstation service before you can display the LAN Manager screen.
In many cases, MS-DOS LAN Manager automatically prompts you to perform the
prerequisite task.

Starting the Workstation Service Automatically
The Workstation service must be started before any of the following commands can
run:

NET
NET NAME
NET USE

NET LOAD
NET PRINT
NET VIEW

NET LOGON
NET SEND
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When you type one of these commands, MS-DOS LAN Manager checks to see if
the Workstation service is running. If it is not, MS-DOS LAN Manager displays
the following prompt:
The WORKSTATION is not started.
Is it OK to start it? (YIN) [Y]:

If you type Y (or press [Return], since Y is the default response noted in brackets),
MS-DOS LAN Manager first starts the Workstation service, then runs the command
you typed. If you type N, MS-DOS LAN Manager does not start the Workstation
service or run the command you typed.

Starting the Messenger Service Automatically
The Messenger service must be running before you can use the NET SEND
command. When you type NET SEND, MS-DOS LAN Manager checks to see if
that service is running. If it is not, MS-DOS LAN Manager displays the following
prompt:
The MESSENGER is not started.
Is it OK to start it? (YIN) [Y]:

If you type Y, MS-DOS LAN Manager starts the Messenger service, then runs the
command you typed. If you type N, MS-DOS LAN Manager will not run the
command you typed, and the Messenger service is not started.

Logging On Automatically
When you type a command that requires you to be logged on to the local area
network first, MS-DOS LAN Manager Enhanced (but not MS-DOS LAN Manager
Basic) checks to see if you are logged on. If you are, MS-DOS LAN Manager
Enhanced runs the command you typed. If you are not logged on, MS-DOS LAN
Manager offers to log you on to the local area network by reading your user name
from the LANMAN.INI file on your computer:
Type your username, or press ENTER if it is <user name>:
Type your password:

2
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Automatic logon can log you on to the 3+0pen network only; it cannot log you on
to a 3+ network, if you are working in a mixed-network environment. Refer to the
LOGON command later in this chapter for more information.
You must be logged on to the local area network before you can use any of the
following four commands:
NET
NET USE

NET ADMIN /COMMAND
NET VIEW

If you are using MS-DOS Manager Enhanced, using these commands before you
are logged on will cause MS-DOS LAN Manager to automatically log you on. If
you are using MS-DOS LAN Manager Basic, you must use the LOGON command
before you use these four commands.

Using Passwords with Commands
Some commands require a password as an option. There are two ways for you to
provide a password.

Typing a Password

The fIrst way to provide a password is to type it on the same line as the command
itself (remember, your password can be up to 14 characters long). For example, if
Mary, whose password is wanderer, wants to use a shared resource plotter on a
server admin that requires a password, she types:
net

use

lptl:

\\admin\plotter

wanderer
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Using the * Option
You can also ask MS-DOS LAN Manager to prompt you for your password, by
replacing the password with an asterisk (*) when you type the command. For
example, Mary could type the following command to connect to the shared resource
plotter:
net

use

1ptl:

\\admin\p1otter

*

MS-DOS LAN Manager displays the following prompt:
Type the password for \\ADMIN\PLOTTER:

When you type a password at this prompt, the password is not displayed as you
type. This allows you to keep your password confidential. Although this option
may prove a little less convenient than typing your command and password
together, it provides added security.
You can use the asterisk option with the following commands to cause MS-DOS
LAN Manager to prompt you for a password:
LOGON
NET PASSWORD

NET LOGON
NET USE

Depending on the command you type, MS-DOS LAN Manager may also prompt
you for other pertinent information, such as your user name.
NOTE: MS-DOS LAN Manager will also prompt you for a password if you forget
to type it with a command that requires one.

2
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Using Iyes and Ino
Some commands cause MS-DOS LAN Manager to prompt you for a decision. For
example, if you use the LOGOFF command to log off from the local area network,
MS-DOS LAN Manager displays a prompt similar to the following:
You have the following remote connections:
LPTl

Continuing will cancel the connections.
Do you want to continue this operation? (YIN)

[N]:

You can use the Iyes and Ino options with any MS-DOS LAN Manager command to
anticipate and respond to a prompt like the one shown. This expedites the function,
because when MS-DOS LAN Manager reads one of these command options, it
does not pause to display the corresponding prompt. Instead, the Iyes or Ino option
is automatically accepted as your response.
For example, if you use the LOGOFF command and know that you want to
respond to the prompt with a Y, you can type the following line:
logoff

/yes

The Iyes and Ino options can also be added to commands in batch fues to keep
functions from being interrupted by MS-DOS LAN Manager prompts. Use this
feature with caution-MS-DOS LAN Manager generally prompts you like this for
safety, to give you a chance to verify that you want to take an action that has
important consequences (like logging off).

Command Reference Pages
Each command reference page in this chapter includes the following information.

Command Name and Purpose
The top of each reference page shows the name of the MS-DOS LAN Manager
command, followed by a brief description of what the command does. Generally,
this description includes information displayed with the command, and the
functions it performs.
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~b~~agrams illustrate command syntax in this manual.
(

NET USE)

A bold, rounded-comer rectangle surrounds the command name.
The command name is in all capital letters and bold type.

drive:

A rectangle surrounds variables. The variable is in lowercase
italic letters. This shape says "substitute something here."
An oval surrounds arguments that you type exactly as they
appear in this manual.

o

A circle surrounds punctuation.

Arrows indicate direction.
A vertical line indicates a return.
Each element must be separated from the next by a space.
To read a bubble diagram, start at the command name, in the bold, rounded-comer
rectangle. You may follow any line through the command, as long as you follow
the direction of the arrows (imagine you are driving a car through a series of
freeway interchanges). For example, when you come to the fIrst decision point in
the NET USE diagram shown next, you could choose to continue to the end
without entering any further parameters. Or, you could take one of the branches
that tell you to type either a device name, or the name of a computer and a
sharename. After that, you must press [Return].

2
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NET USE ~~----------------------~~--~

devicename

....

I-------_~

I

\ \ computername\sharename ....-.....,

Following the bubble diagrams are explanations of all the options you can use with
each command. Most option names can be abbreviated.

Comments
The comments section describes how to use the command, when to use it, and
why. This section describes the command's options and explains which options
can be used in combination. The comments section may also contain warnings or
suggestions about using the command.

ExamDle

Exampfes show how the command is used. In the 3+0pen MS-DOS IAN
Manager User Guide, you were introduced to employees of a fictitious company,
MacroCorp, Inc. The examples in this chapter also use the names of MacroCorp
employees.

See Also
At the end of each command reference page is a list of titles of command and dialog
box reference pages and other publications that you can read for more information
related to the command.
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Basic Commands
The following table lists the commands used with MS-DOS LAN Manager Basic.
These commands are available to all users of MS-DOS LAN Manager, either Basic
or Enhanced. Each command is discussed in detail on its own reference page.
In the next section of this chapter, Enhanced Commands, commands are listed that
are available only to users with MS-DOS LAN Manager Enhanced, which includes
the LAN Manager screen. If you are uncertain which version of MS-DOS LAN
Manager you are using, check with your network administrator.

Table 2-1. MS-DOS LAN Manager Basic Commands
Purpose
Command
LOGOFF
LOGON
NET CONTINUE
NET HELP
NET NAME
NET PAUSE
NET PRINT
NET START WORKSTATION
NET USE

Lo~

you off 3+0pen or 3+ networks (or
bot ).
Loe: your user name and password into
3+ pen or 3+ networks (or both).
Continues local area network functions
suspended by the NET PAUSE command.
Displa~ information about the purpose and
use of S-DOS LAN Manager commands.
Displays the aliases currently defined in a
netstauon's list of aliases, and adds or deletes
aliases from that list.
Suspends the specified MS-DOS LAN
Manager functIons.
D~splays and controls the contents of a shared
pnnter s queue.

Starts MS-DOS LAN Manager services.
Connects users to resources shared by a
server.
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LOGOFF
This command ends a computer's connection with the local area network and logs a
user name off from the local area network. LOGOFF can be used to log off from
both 3+Open and 3+ networks. MS-DOS LAN Manager Enhanced has a similar
command, NET LOGOFF, which is used to log off only the 3+0pen network.

Syntax
LOGOFF
/3plus
/30pen

Comments
The LOGOFF command is used to end a user's local area network session. Since
only one user per netstation can be logged on to the local area network at a time,
logging off one user name frees the netstation for use by someone else.
LOGOFF with no options logs you off both the 3+0pen and 3+ networks. A
message is displayed, confirming each network logged off:
username successfully logged off the 3+0pen network
username successfully logged off the 3+Name service

You can also specify a particular network with the 130pen and 13plus options.
Adding the Iyes option at the end of the command means that MS-DOS LAN
Manager will not prompt you for confirmation before cancelling any connections
currently in effect.

2
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If you are actively using any shared resources (for example, your current drive is a
redirected drive), you must stop using those resources before you can log off. If
you have any connections to a server's shared resources when you use the
LOGOFF command, MS-DOS LAN Manager warns you that logging off deletes
those connections. Messages similar to the following will be displayed:
NET2404:

The device is being accessed by an active process

You have the following remote connections:
H:
I:

Continuing will cancel the connections.
Do you want to continue this operation?

(YIN)

[N]:

If you respond with Y, your current connections will be broken, and you will see
messages confmning that you have been logged off.

Once the LOGOFF command has been completed, you no longer have active user
name, password, or local area network sessions, and you cannot receive messages
sent to your user name.

Example
At the end of the day, to log off from the local area network, Jenny types:
logoff

See Also
For more information about this command, see:
•

The LOGON command in this chapter, for information about logging on.

•

The Log Into Network dialog box in Chapter'3: LAN Manager Screen
Reference, for information about logging on to MS-DOS LAN Manager
Enhanced.

2
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LOGON
This command sets the user name and password for your netstation. The LOGON
command logs you on to either 3+Open or 3+ networks, or both. Do not confuse
LOOON with NET LOGON (available in MS-DOS LAN Manager Enhanced),
which logs you on to the 3+0pen network only.
LOGON is quite versatile. The three syntax diagrams below show three different
ways to use LOGON.

Syntax
1.

Log on to both networks.

2.

Log on to 3+Open network only.
3+0pen
password

3+
password
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3.

Log on to 3+ network with a three-part name.

Option

Abbreviation

usernome

Purpose

3 + Open

Specifies the default user name for the local
netstation (up to 20 characters long).
You can type an asterisk instead of your
E:assword to cause MS-DOS LAN Manager
nhanced to prompt you for your password.
Password to be used on 3+0pen network.

3+

Password to be used on 3+ network.

1'lf1J11e:

The puee-part name recognized by the 3+Name
service.
Required if you are speci~ng a threecfJart name
for the 3+Name service ( lows LOG N to
distinguish the end of the three-part name).

*
password
password
domain:org

/pass=

/30pen

/30

Forces LOGON to log on to 3+0pen only.

/3plus

/3p, /3+

Forces LOGON to log on to 3+ only.

2

MS-DOS LAN
Manager Command
Reference

2-16

options may be any or all of the following:
Option

Abbreviation

Pur~

/no_pro

/np

Causes LOGON to not load profile files for
either the 3+0pen network grnTLOGON.PRO)
or the 3+Name service (PR FILE.SYS).

/30pen

/30

Forces LOGON to log on to 3+Open only.

/3plus
/yes

/3p, /3+
/y

Forces LOGON to log on to 3+ only.
Skips confinnation prompts as if you had
answered yes.
Sets environment variable used by redirector
to computername, to specify the home server
for Start volume users and netstation clock.
Specifies that net station clock will not be set
from 3+Name server or home server.
Displays a help screen for the LOGON
command.
Sets an environment variable used for
establishing the initial Start volume connection.

!home_server= !hs=

computername computername

/no_time

/nt

/help

help, I?, ?

/security=
user or share

/SE=
user or share

Comments
The LOOON command is usually put into your netstation's AUTOEXEC.BAT file
by the NETSETUP program. This way, logging on is handled each time you start
your netstation. LOGON establishes your user name and password on the
network. It works on networks that contain only 3+0pen servers, as well as
networks containing both 3+0pen and 3+ servers.
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General Usage
When you use the LOGON command with no options, you are prompted for a user
name and password. Similarly, if you type the LOOON command with just a user
name and no password, it is assumed that no password is required.
Hyou type an asterisk after the user name (in place of either the 3+Open or
3+ password, or both), then you are prompted to supply a password:
Enter your 3+0pen password:
Enter your 3+Name service password:

Characters you enter will not be displayed, thereby keeping your password secure.
When you enter just one user name and one password, they are used to attempt to
log on to the 3+0pen network and to the 3+Name service. If LOGON is successful
in logging on to the 3+0pen network, it displays the message:
username successfully logged on the 3+0pen network

(username is your user name).
When logging on to the 3+Name service, the user name you supply LOGON is
treated either as an alias or as a user name under the default Name service domain
and organization. If 3+Name service logon is successful, you will see the message:
3+ User name:domain:org successfully logged on the 3+Name service

name:domain:org is a three-part name recognized by the 3+Name service. If you
supply an alias with the command, the 3+Name service translates it into a three-part
name. If you supply your user name, the three-part name consists of your user
name and the default domain and organization associated with your name.

2

MS-DOS LAN
Manager Command
Reference

2-18

If your netstation is already logged on under a different user name and has remote
connections, LOGON flrst displays a prompt similar to this:
You have the following remote connections:
H:
I:

Continuing will cancel the connections.
Do you want to continue this operation? (yiN):

If you answer yes (by pressing Y), LOGON cancels these connections. In essence,
your netstation will be logged off before it is logged on again. However, if any of
your network connections are currently in use (for example, if your current drive,
as shown by the MS-DOS prompt, is one of your redirected drives), LOGON
displays the message:
NET2404:

The device is being accessed by an active process

LOGON cannot continue in this case, and stops.
The LOGON command also tries to add the specifled user name as an alias for the
netstation. If the user name cannot be added as an alias, MS-DOS LAN Manager
Enhanced logs you on to the local area network, but displays a warning message.

Logging On to Mixed Networks
A mixed network is one in which there are both 3+0pen and 3+ servers, and which
includes the 3+Name service. LOGON is designed to take care of logging in to
both networks.
If your network does not provide the 3+Name service, LOGON will detect this
automatically and log you on to the 3+Open network only.
It is simplest when your user name and password are both the same for both
networks. For example, if your user name is marys, and your password is
wanderer, for both networks, use the LOGON command like this:
logon

marys

wanderer
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If you have the same user name but different passwords on both networks, you can
put both passwords in the command. If your 3+ password is traveler, then the
LOGON command would look like:
logon

marys

wanderer

traveler

In this example, marys is your user name on both networks, wanderer is your
3+0pen password, and traveler is your 3+Name service password.
LOGON can also take 3+Name service logon infonnation from the name= and
password= lines in your netstation's PROFILE.SYS file. PROFILE.SYS must be
located in your current directory. This may be convenient if you use a three-part
name for the 3+Name service, or if you use different user names and/or passwords
on 3+Open and 3+Name service. This will happen automatically unless you
append the option /no-pro to the command, like this:
logon

marys

wanderer

/no-pro

You can also run LOGON twice: once for each network. This also allows you to
use three-part names or different user names on both networks. The commands
might look like this:
logon
logon

marys wanderer /30pen
msmith:finance:macrocorp

/pass=traveler

/3plus

The options /30pen and /3plus determine which network LOGON will log you
on to.
If your user name is registered with the 3+Name service, but your 3+0pen
password is not correct as a 3+ password, you will see the following message:
Enter 3+Name service password:

Enter the correct password at this prompt. LOGON then gives you the opportunity
to change your 3+Name service password to match your 3+0pen password:
Change the 3+Name service password to match the
3+0pen password? (yiN):
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If you press Y, you will be asked to type the 3+0pen password again (this is done

partly for security, and partly to ensure you correctly remember the 3+Open
password):
Enter your 3+0pen password:

If the two passwords match, LOGON will change your password in the 3+Name
service and confirm with the following message:
Password successfully changed on the 3+Name service.

If your 3+0pen and 3+ passwords are different, you should consider making them

the same. This will simplify use of the network for both you and your network
administrator.

Logging On to the 3+0pen Network
The /30pen (/30) option directs LOGON to log on only to the 3+0pen network.
For example:
1ogon

marys

wanderer

/30pen

You might want to use this form of the LOGON command if you are currently
logged on to both networks, and you wish to change only your 3+0pen logon.
If your 3+0pen network uses logon security (by keeping a distributed or centralized

database of user names and passwords on one or more servers), then your user
name and password are sent to the server for verification. If the logon server
recognizes the user name/password combination you gave, you are allowed to log
on to the local area network. If you have a logon script associated with your
account, MS-DOS LAN Manager Enhanced runs the script on your netstation when
you log on to the local area network. (This script is contained in a file on the logon
server.)
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Logging On to the 3+Name Service
The /3plus (J3p, /3+) option directs LOOON to log on only to the 3+Name service.
For example:
1ogon

msmith

trave1er

/3p1us

Like logging on to only the 3+0pen network, this fonn of the LOGON command is
useful to change your logon to 3+ while not changing your logon to 3+Open.
IT you wish to use a tbree-part name for your 3+ logon you must use a specific
fonn of the LOGON command:
1ogon

name: domain: org

/pass=password

/3p1us

Here name:domain:org is your three-part name. The option /pass= is required
because three-part names can contain spaces; /pass= tells LOGON where the threepart name ends and the password begins. Note also that you cannot mix a threepart name and a 3+0pen user name. You must either use LOGON twice, as
described earlier, or put your 3+Name service logon infonnation in the
PROFILE.SYS file.

Changing Your Password
You can use LOGON to change the password currently in effect. You might want
to do this if you have separate passwords for different resources on the network, or
different privilege levels. Note that this is a temporary change; the next time you
start your netstation, the LOOON command(s) in AUTOEXEC.BAT will use your
original password. If you want to change your password permanently, edit the
LOGON command in AUTOEXEC.BAT.
To change only your 3+0pen password, type the LOGON command like this:
1ogon

username password

/30pen

In this case, username is your original user name, and password is the new
password. This fonn of the command won't cancel any current connections, and
will register the new password with the 3+0pen network.

2
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Automatic Logon
Certain MS-DOS LAN Manager commands require you to be logged on to the
network before they can be used, as described earlier in this chapter, in the section
"Logging On Automatically." These commands automatically run the NET
LOGON command before they proceed with their own functions. Remember that
NET LOGON does not provide the full functionality of the LOGON command on
mixed networks; if your network requires you to log on to both the 3+Open
network and the 3+Name service, be sure you have used LOGON before you
attempt any of the commands that require you to be logged on to the network.

Example

For Jenny to establish her user name,jennyt, and password, babaloo, as the
defaults on a netstation, she types:
logon

jennyt

babaloo

If Jenny's network contains both 3+0pen servers and the 3+Name service, she
sees the following prompts as confirmation:
jennyt was successfully logged on to the 3+0pen network
jennyt:finance:macrocorp was successfully logged on to the 3+Name
service.

The second line of the message shows that Jenny's user name, jennyt, was
translated by the 3+Name service into a three-part name, containing her name,
domain (macrocorp), and organization (finance).

See Also
For more information about this command, see:
•

The NET LOOON command, for information about MS-DOS LAN Manager
Enhanced's 3+0pen logon capabilities.

•

The Config->Logon menu in Chapter 3: LAN Manager Screen Reference, for
information about the Log Into Network dialog box.

•

The LOGOFF command, for information about logging off the network.
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NET CONTINUE
This command continues MS-DOS LAN Manager services suspended by the NET
PAUSE command.

Syntax
NET CONTINUE

Option

Purpose

workstation

Continues local area network connections to all parallel (LPT)
ports and disk drives.

prdr

Continues local area network connections to printer ports only.

drdr

Continues local area network connections to disk drives only_

NET CONTINUE may be abbreviated NET CONT.
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Comments
The NET CONTINUE command reinstates services or resources that were paused
using the NET PAUSE command. Specifically, you can pause and continue the
Workstation service, or pause and continue connections to parallel (LPT) ports or
disk drives only.
When you continue local area network connections to network printers, any local
connections to parallel (LPT) ports are ignored, and connections to local area
network resources are restored.
For example, suppose you have a dot-matrix printer connected to LPTI of your
netstation. You may choose to redirect LPTI to a laser printer on the local area
network, then pause your local area network connections when you want to use the
dot-matrix printer. When you are ready to use the laser printer again, the NET
CONTINUE command causes your netstation to redirect LPTI to the network laser
printer and ignore the local dot-matrix printer connection.

Example
Mike Greenbaum paused the Workstation service on his computer earlier in the day.
Now he wants to use local area network resources, so he continues the Netstation
service by typing NET CONTINUE WORKSTATION.

See Also

For more information about this command, see:
•

The NET PAUSE command in this chapter, for information about pausing
MS-DOS LAN Manager services.

•

The Network Resources in Use at Your Workstation dialog box, in Chapter 3:
LAN Manager Screen Reference, for information about pausing and continuing
your local area network connections from the LAN Manager screen.
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NET HELP
This command provides infonnation at the MS-DOS prompt about how to use
MS-DOS LAN Manager Basic commands.

Syntax
(

NET HELP)

1:'1 ..

command

~

r'

I

command may be one of the following MS-DOS LAN Manager Basic commands:
CONTINUE

NAME

PRINT

START

PAUSE
USE

2
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Comments

When used without options, the NET HELP command displays a list of all
MS-DOS LAN Manager commands. You can type NET HELP, followed only by
the second word of the MS-DOS LAN Manager command. For example, if you
want help in using the NET USE command, type:
net

help

use

In response, NET HELP displays information about the NET USE command:
The syntax of this command is:
NET USE [devicename I \\computername\sharename]
NET USE [devicename] \\computername\sharename [password]
NET USE {devicename I \\computername\sharename} /DELETE
The NET USE command connects a netstation's local devicename to a
server's shared resource.
See the MS-DOS LAN Manager User Reference for more information
about this command.

NOTE: You can also see help infonnation for an MS-DOS LAN Manager
command by typing the command in the following fonn:
command

/help

For example, you could see infonnation about the NET LOAD command by typing
either of the following commands:
net
net

help
load

load
/help
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You can type a command in the following form to see infonnation about syntax for
that command only:
command /?

For example, if you were interested in seeing only what the proper syntax for the
NET PRINT command is, you could type:
net

print

/?

Example

To get lielp with options and syntax associated with the NET PRINT command,
Mike types:
net

help

print

See Also
For more infonnation about the NET HELP command, see:
•

The NET HELP command in the third section of this chapter, for the version of
NET HELP that displays the commands for MS-DOS LAN Manager Enhanced.
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NET NAME
Under MS-DOS LAN Manager Basic, NET NAME displays your netstation's user
name.

Syntax
(NET NAME

H

Comments

NET NAME displays your netstation's user name when you are running MS-DOS
LAN Manager Basic. When you are running MS-DOS LAN Manager Enhanced,
this command displays more information about aliases at your netstation and allows
you to change them.

Example
Jimmy Wilson has forgotten his user name. To find out, he types:
net

name

NET NAME displays his user name:
Name
JIMMYW
The command completed successfully.

See Also
For more infonnation about this command, see:
•

The NET NAME command in the third section of this chapter, describing the
use of NET NAME if you are using MS-DOS LAN Manager Enhanced.
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NET PAUSE
This command suspends an MS-DOS LAN Manager service or connection to a
shared resource, and frees up memory used by a service.

Syntax
NET PAUSE

Option

Purpose

workstation

Pauses local area network connections to all parallel (LPT) ports
and disk drives.

prdr

Pauses local area network connections to printer ports only.

drdr

Pauses local area network connections to disk drives only.
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Comments
When you pause the Workstation service, you temporarily suspend connections
from your netstation to network printers and disk drives, and free memory on your
computer for use by other programs you want to run. When you pause a
connection to a shared resource, you temporarily suspend the connection between
your netstation and the shared resource.
For example, you might want to pause the connection between a shared printer and
your netstation's LPTI port if you have connected a printer to that port temporarily.
To restore a paused resource or service, use the NET CONTINUE command.

Example
To pause the connection between a shared printer and his netstation, Ben types:
net

pause

workstation

When Ben is ready to resume this local area network connection, he types:
net

continue

workstation

See Also

For more information about this command, see:
•

The NET CONTINUE command in this chapter, for information about
continuing paused services.
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NET PRINT
This command displays and controls the contents of a shared printer queue.

Syntax
NET PRINT ~---------'~------------~~---'~~r----'~--~~

\ \computername

1-----'.

\ \ computername \sharename
\\computername\devicename

Option

Purpose

\\.computername
sharename
devicename
job#

Specifies the server sharing the printer queue.

/hold

/release
/delete

Specifies the shared printer queue.
Specifies the local print device connected to the queue.
Specifies the identification number assigned to a file in a
queue.
Keeps a print job from printing. Print jobs held in the queue
with. the /hold option stay in the queue and are not printed
until released WIth the /release option.
Releases a held job from the queue.
Breaks the connection with the printer queue; removes all of
your print requests in the printer queue. Or, if you specify a
print Job, removes the print job from the printer queue.

2
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Comments

When used with the \\.computername option, the NET PRINT command displays
infonnation about a specific printer queue. For example, the contents of a printer
queue in a MacroCorp server \\printl might be displayed as follows:
Printer Queues at \\PRINTI
Name

Job#

FAST PRT Queue
JACKST
JENNYT
JENNYT

3 jobs
1

3
4

Size

Status

2509
75
75

*Queue Active*
Printing on LPTI
Waiting
Waiting PRT Queue

The command completed successfully.

This display lists:

Column

Contents

Name

Sharename of the printer queue and the user name of the owner for
each job sent to the queue.

Job#

Identification number of each print job.

Size
Status

Size in bytes of each print job.
Status of each print job (Printing, Paused, Error) or Spooling), or
the status of each queue and the number of jobs m it.
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When used with the computer name and sharename of a queue, or with the
redirected device name, the NET PRINT command displays only information about
the specified queue. This display includes the status of the queue itself and a list of
the jobs in the queue, including the size and status of each job. Print jobs for
printers controlled by MS OS/2 LAN Manager servers are listed under a single
heading, as if they consisted of one large printer queue.
The status of a printer queue can be OK, Held, Held until, Pending delete, or Error.
The status of a print job can be Spooling, Held, Printing on (device), Held on
(device), Out of paper on (device), Error on (device), Offline on (device), or
Waiting.
Print jobs to be held or released (with the !hold and /release options) can be
specified either by the device name, or by the computer name of the server plus the
sharename of the queue. For example, if your netstation's LPTI device name is
redirected to a queue \\mis\print, any of the following commands will hold a job
(identification number 24):
net
net
net

print
print
print

l.pt2 24 /hol.d
\ \mis \print 24
\ \mis 24 /hol.d

/hol.d
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Example

Realizing that he sent the wrong monthly budget to a shared printer queue laser on
the print1 server, Jack wants to delete his print request. First, he types the
following command to see what identification number is assigned to his print
request:
net

print

\\printl\~aser

The following display appears:
Print Queues at \\PRINTl
Name

Job#

LASER Queue
BENS
JACKST

2 jobs
6
7

Size

Status

2527
3074

*Queue Active*
Printing on COMl
Waiting

He sees that his is request number 7. Next, Jack deletes his print request by typing:
net

print

\\printl\laser

7

/delete

See Also
For more information about this command, see:
•

The Printer Queues for (Server) dialog box in Chapter 3: LAN Manager Screen
Reference, for information about working with printer queues using the LAN
Manager screen (if you have MS-DOS LAN Manager Enhanced).
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NET START WORKSTATION
This command starts the MS-DOS LAN Manager Workstation service.

Syntax
(NET START WORKSTATION

H

Comments
The MS-DOS LAN Manager Basic version of the NET START COMMAND has
no options on its command line, unlike the Enhanced version, described later in this
chapter. NET START WORKSTATION is included in your netstation's
AUTOEXEC.BAT flie by the NETSETUP program to start the Workstation service
automatically each time you start your netstation. If the command has been
removed from your AUTOEXEC.BAT file, you can type it at the MS-DOS prompt.

Example

John has removed the NET START WORKSTATION command from his
AUTOEXEC.BAT file. When he arrives at work in the morning, he turns on his
computer and types the following command to start the Workstation service:
net

start

workstation

See Also

For more information about this command, see:
•

The NET START WORKSTATION command for MS-DOS LAN Manager
Enhanced, later in this chapter.

2
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NET USE
This command redirects a netstation's local device name to a server's shared
resource.

Syntax
1.

Making a connection
NET USE

2.
(

3.

devicename

\ \computername\sharename

Deleting a connection
NET USE)-1

devicename

J-C:::

/delete

:>-4

Getting information about connections
NET USE

devicename

I-------__~..,

\\computername\sharename

~~-

1ooIr-------......
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Option

Purpose

devicename

S~cifies the name of thed:arallel port (for example, LPTl) or
dIsk drive (for example, :) you are using locally to identify a
shared printer or directory.

\\computername

Specifies the server controlling the shared resource.

\sharename
password

Specifies the shared resource.
For servers with share-level security, this specifies the
password assigned to the shared resource. For servers with
user-level security, this specifies the user's password to the
server controlling the requested resource, if it is different
from the password set with the LOGON command. You can
&be an asterisk (*) instead of your password to cause MSS LAN Manager Basic to prompt you for your password.

Idelete

Disconnects a local area network connection.

Comments
When used without options, the NET USE command lists the netstation's
connections. The display lists the status, associated device, and sharename of each
connection. For example:
Status

Local name

DISCONNECTED

G:

OK

M:

ERROR

LPTl

Remote name
\\GENERAL\C
\\MIS\SCRATCH
\\PRINT1\LASER

The command completed successfully.
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When used with just the device name or just the server's computer name and
sharename, the NET USE command displays infonnation about a specific
connection. For example:
net use \\admsvc\requests
Local name R:
Remote name \\ADMSVC\REQUESTS
Type
Disk
Status
OK
Open count
1
Use count
1
The command completed successfully.

This display shows:
Field

Contents

Local name

The device name of the device connected to the shared resource.

Remote name

The sharename of the shared resource.

Type

The type of shared resource being used: Disk or Printer.

Status

The status of the connection: OK, Error, or Disconnected.

Open count

The number of times a fue was opened via this connection.

Use count

The number of connections you have to the shared resource.

If you type the NET USE command before you log on to the local area network,

MS-DOS LAN Manager prompts you to log on. (This is because MS-DOS LAN
Manager must validate your user name and password before allowing you access to
shared resources.)
You cannot disconnect a local device name from a server if that is your current
drive. You must frrst change to another drive. Also, if you try to disconnect from
a shared-disk resource when files are still open on the server, MS-DOS LAN
Manager displays a warning message and asks you to confmn your decision.
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A connection listed as disconnected means that a server ended your session due to
inactivity. In most cases, MS-DOS LAN Manager automatically reestablishes this
connection the next time you try to use the resource. You do not have to retype the
NET USE command to reestablish the connection.

Example

.

To connect her netstation's E: device name to a shared directory with the sharename
letters controlled by the general server, Debbie types:
net

use

e:

\\general\letters

Later, Debbie wishes to connect her netstation's D: device name to a shared
directory with the sharename drY_c, which shares the entire contents of drive Con
the general server. drY_c requires the password goddess. Debbie types:
net

use

d:

\\general\drv_c

goddess

To connect her netstation's print device LPTI to the shared printer with the
sharename laser2 controlled by the print2 server, Debbie types:
net

use

lptl:

\\print2\laser2

When Debbie is ready to disconnect from this resource, she types:
net

use

lptl:

/delete

2
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See Also
For more information about this command, see:
•

The LOOON command in this chapter, for information about logging on to the
local area network.

•

The NET SAVE command in this chapter (if you have MS-DOS LAN Manager
Enhanced), for information about saving your netstation's current resource
connections to a profile file.

•

The NET LOAD command in this chapter (if you have MS-DOS LAN Manager
Enhanced), for information about restoring saved resource connections from a
profile file.

•

The Use a Shared Resource dialog box in Chapter 3: LAN Manager Screen
Reference (if you have MS-DOS LAN Manager Enhanced), for information
about connecting a device to a shared resource using the LAN Manager screen.
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Enhanced Commands
The following table lists the commands used with MS-DOS LAN Manager
Enhanced. If you are using the Basic version of MS-DOS LAN Manager, only the
commands listed in the previous section of this chapter are available to you. If you
are uncertain which version you are using, check with your network administrator.

Table 2-2. MS-DOS LAN Manager Enhanced Commands
Purpose
Command
NET
NET ACCESS
NET ADMIN /COMMAND

Starts the user version of the LAN Manager
screen.
Allows a network administrator to change
permissions on a server from a netstation.
Allows a network administrator to run a
command on a server while using a netstation.

NET COpy
NET HELP-

Copies files both locally and remotely.
Disp'lays information about the purpose and use
of MS-DOS LAN Manager commands.

NET LOAD
NET LOGOFF

Loads a saved configuration from a file.
Disconnects all 3+0p'en network sessions and
logs a user off from the 3+0pen network.
Logs a user on to the 3+0pen network and sets
the user name and password for the netstation.
Moves files from one place to another on the
local area network.

NET LOGON
NET MOVE
NET NAME
NET PASSWORD

Sets aliases for the netstation.
Changes the password for logging on to a
server.
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Table 2-2. MS-DOS LAN Manager Enhanced Commands (continued)
Purpose
Conunand
NET SAVE

Saves the current local area network
configuration into a file for later use.

NET SEND
NET START MESSENGER

Sends messages and files to other users.
Starts the MS-DOS LAN Manager Enhanced
Mes~enger service, allowing you to send and
receive messages.
Starts the MS-DOS LAN Manager Enhanced
Netpopup service, displaying messages as they
are received.
Starts the Workstation service, registers the
netstation's user name, and sets various options.
Displays the com~uter names of servers and the
resources being s ared by any server.

NET START NETPOPUP
NET START
WORKSTATION
NET VIEW
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NET
This command displays the LAN Manager screen.

Syntax

(NET

H

Comments
The LAN Manager screen lets you perfonn MS-DOS LAN Manager Enhanced
operations using menus and dialog boxes. You must start the Workstation service
before using this command.
If you have not logged on to the local area network, the Log Into Network dialog
box appears with the LAN Manager screen. This dialog box can only log you on to
the 3+Open network. You must use the LOGON command (described at the
beginning of this chapter) if your network includes the 3+Name service.

2

MS-DOS LAN
Manager Command
Reference

2-44

Example
To run the LAN Manager screen, Mike types the following command at the
MS-DOS prompt:
net

The LAN Manager screen appears.

See Also
For more information about this command, see:
•

Chapter 3: LAN Manager Screen Reference, for a description of each LAN
Manager screen menu and dialog box.

•

The 3 +Open MS-DOS IAN Manager User Guide, for information about using
the LAN Manager screen.
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NET ACCESS
This command allows a network administrator to list, create, change, and revoke
permissions for resources at a server.

Syntax

2
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Option

Purpose

resource

Names the resource to be assigned permissions. The resource
can be a disk, directory, file, printer queue, or pipe.
Identifies the user name or group name of a specific account
whose permissions are being mOdified.
Specifies an account name and permissions to be set, in the form
account:permissions. The name of a user or group account is
followed by the permissions for the resource (R, W, C, X, D,
A, P, Y, N; these are explained later in this section).
Removes permissions for a resource from the access-control
database.

account
rights

/delete
/add

Adds permissions for a resource to the access-control database.

/change
/grant

Changes a user's or group's permissions for a resource.
Adds .a l).ew user name and corresponding permissions to a
preexlsnng resource record.
Turns audit trailing on or off for a particular resource. (The
default is yes.)

/trail: [yeslno]
/revoke

/tree

Revokes a user's or group's permissions to use the resource.
Reports permissions for the resource specified and all of its
descendants (for example, subdirectones of a specified
directory) .
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When used without options, the NET ACCESS command displays a list of the
server's shared resources plus their assigned permissions. For example:
Resource

Permissions

Permissions

\PRINT

BENP:W
JACKST:W
MIKEG:WC

GUEST:WC
MARYS:WC
*USERS:WC

C:\

GUEST:R

*USERS:R

C:\LANMAN\SPOOL

GUEST:R

*USERS:R

The command completed successfully.

This display shows the pathname of every resource and the permissions assigned
for that resource. (Group names are preceded by *.)
NOTE: If you type the NET ACCESS command for a network resource, the path
in the Resource column is relative to the network server, not to your local
computer.

2
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Comments

Before you can use the NET ACCESS command, you must:
•

Be sure that the server is started with user-level security (3+0pen servers only).

•

Make sure the resource exists.

•

Have existing accounts for the users or groups for which you are assigning
permissions.

The NET ACCESS command works only with 3+Open servers; it will not work
with 3+ servers.
When you use the NET ACCESS command to display access permissions, a
comment next to each resource's name shows whether access of that resource is
being audited. Under each resource name are the names of users and groups
permitted to use the resource, and the specific permissions. Three types of
resources can appear in the list:
•

Pathnames of drives, directories, or files

•

Sharenames of printer queues

•

Pathnames of named pipes
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The NET ACCESS command can assign up to nine pennissions. These
pennissions apply only when the server is running with user-level security. Some
pennissions work only with specific types of resources:

Utter

Permission

R

Read lets users read and copy files in that directory, but not change
them. This also lets users view the names of files in a shared directory.
Use this pennission by itself if you want users to be able to look at or
execute programs only.
Write lets users make changes to the files in that directory. In most
cases, it should be used in combination with read pennission.
Create lets users create files and subdirectories in the shared directory.
When used by itself, this pennission lets users create new files in the
directory and change them while they are creating them; once the flie is
closed, they cannot modify it.

W
C

X

Execute lets users run a command or program.

D
A

Delete allows users to delete files and subdirectories.
Change attributes lets users chanl5e file attributes. For more infonnation
about file attributes, see the MS S/2 User Reference.
Change permissions lets users change resource pennissions. (This is
the same as giving a user administrative privilege for a resource.)

p
Y
N

Yes allows users to submit files or requests to a printer queue.
No denies users access to a resource, and is useful if you need to
exclude a specific person or persons from using a printer queue,
directory, or file.

Only users who are assigned the pennission P can change the permissions on a
shared resource using the NET ACCESS command. Otherwise, administrative
privilege on your server account must be obtained before pennissions for resources
shared from that server can be changed.
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For a resource to be audited, the NET ACCESS command must be used with the
name of the resource, and the /trail: option must be set to yes. Since yes is the
default for this option, if you type the trail option with no value, auditing is
turned on.

Example
To add permissions on the files in the bin directory for the user mikeg and the
groups pubrel and users, Mary types:
net

access

c: \bin

/ add mikeg: rwxc

pubrel:rw

users:r

Later, to give Jenny Tibbett read and write permission for the same directory, Mary
types:
net

access

c:\bin

/grant

jennyt:rw

See Also
For more information about this command, see:
•

The 3 +Open OS/2 LAN Manager Administrator Guide, for an explanation of
how a network administrator can start a server with user-level security or assign
access permissions.
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NET ADMIN /COMMAND
This command allows a network administrator to run a command remotely on a
3+0pen server.

Syntax
/ / computername \ . c - - - - - - , . I . . - r

Option

Purpose

computername

S~e~if!es the ~omputer. name of the server the network
a mInIstrator IS accessIng.
Specifies the network administrator password on the computer
name.
Starts a secondary command processor or runs command at
computer name.

password

Icommand
command

A command that will be run on the accessed server.

Comments

When you use the Icommand option without a following command, a command
processor similar to the MS-DOS COMMAND. COM command processor is started
and runs at the designated 3+0pen server. This command processor prompts for
commands, runs them, and returns the resulting output to your screen.
While using this command processor, you must type the full pathname of each
command. For example, if you start a command processor at a network server,
then want to see a directory listing for a directory called macrocorp on that server,
type the DIR command, followed by the drive letter and path of the directory:
dir

f:\macrocorp
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If you do not specify a full pathname when you type commands for a network
server, MS-DOS LAN Manager Enhanced assumes a path of lanman\netprog on
that server.

To exit from this command processor, type exit, or press [Ctrl]+Z.
You can also type the NET ADMIN command in the following form to run a single,
noninteractive command (command) at the 3+0pen server:
net

admin

\ \computername

[password]

/command

command

Three rules apply to the command option:
You must type the text of command within quotation marks. For example:
net

admin

\ \server

/command

"net

stop

server

/yes"

If command ends with a backslash character (\), be careful to add either an extra
space or another backs lash character before the ending quotation mark. For
example, the following command would not work properly:
net

admin

\\server

/command

"net

share

c=c:\"

Instead, you could use anyone of these commands:
net

admin

\\server

/command

"net

share

net

admin

\\server

/command

"net

share

net

admin

\\server

/command

net

share

c=c:\\"
c=c:\

"

c=c:\

If command includes a multiple-word argument, command must be surrounded by
one set of quotation marks, and the argument must be surrounded by another set.
For example:
net admin \ \server
/srvcomment:"Remote

/command "net
server 1""

confiq

server
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Example
To start a network administration session for the server print2, where the
administrative password is admiral, Mike types:
net

admin

\\print2

admiral/command

The following message appears:
Type Exit or

AZ

to exit.

The prompt at Mike's netstation changes to include the computer name print2.
Now all of the commands Mike types at his netstation run on the server print2.
When he is done working with the network server, Mike types exit and his prompt
reverts to the normal prompt for his netstation.

See Also
For more information about this command, see:
•

The 3 +Open OS/2 LAN Manager Administrator Guide, for information about
administering a network server.

2
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NET COpy
This command copies files, both locally and remotely.

Syntax
NET COpy

pathnamel~--

__--~~__----~----~~------__~~
pathname2

pathnamel+pathname[ ... ] ~--~~----~--~------

Option

Purpose

pathnmnel
pathname2

Names the file being copied.
Specifies the~athname the file is copied to. If pathname2 is
omitted, NE COpy copies the file Into the current directory.
Appends one or more files to pathnamel and places the result
In pathname2.
Causes MS-DOS LAN Manager Enhanced to verify that
information was properly recorded on the destinatIon drive.

+pathname[ ... ]
/v
/a

Copies files in ASCII (text) format.

/b

Copies files in binary format.
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Comments
The NET COpy command is similar to the MS-DOS copy command, allowing you
to copy files over the local area network. You can copy files:
•

From one location to another on your netstation.

•

Between a network selVer and your netstation.

•

From one location to another on a network selVer.

•

From one network selVer to another network selVer.

If you do not specify the pathname2 option, the copy is created in the working
directory on the disk in the default drive of your local computer. This copy has the
same name, creation date, and creation time as the original file (pathnamel). If the
original file is on the default drive and you do not specify pathname2, the NET
COpy command quits (you are not allowed to copy a file to itself), and MS-DOS
LAN Manager displays the following error message:
File cannot be copied onto itself
o File(s) copied

The Iv option lets you verify that critical data has been correctly recorded; it also
causes the NET COpy command to run more slowly, because MS-DOS LAN
Manager Enhanced must check each entry recorded on the disk. If MS-DOS LAN
Manager cannot verify that the flie was copied successfully, it displays an error
message.
Options la and /b perform differently, depending on whether they are placed
following the source filename or the target filename.
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When placed after the source filename (pathnamel):
•

The fa option causes the file to be treated as an ASCII (text) file. Data in the file
is copied up to but not including the first end-of-file mark. The remainder of
the file is not copied.

•

The!b option causes the entire file to be copied, including any end-of-file
marks.

When placed after a target filename (pathname2):
•

The fa option causes an end-of-file character to be added as the last character of
the file.

•

The!b option does not add an end-of-file character.

If you use the NET COPY command to copy files from one place to another on
your netstation, or from one computer to another on the local area network, the
names of the files are listed as they are copied. When you copy files from one place
to another on a single network server, only the number of files copied is displayed;
the names of the files are not displayed.

You can use full network pathnames, including computer names, with the NET
COpy command. You do not need to connect to a network file or directory to copy
it with the NET COpy command; connections are made automatically. However,
you must have the necessary permissions (that is, read permission) for making
connections.
U sing NET COpy to copy a file from one place to another on a network server is
quicker than connecting to that network server and then copying files with the
MS-DOS COpy command.
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Example
To copy a mailing list from the lists directory on the \\sales server to the address
directory on the same server, Olga types:
net

copy

\\sales\lists\mail.txt

\\sales\address\mail.txt

To copy an interoffice memo from one server 0,\humanr) to another 0,\printl), Olga
types:
net copy \\humanr\olgar\memo0513.doc
\annual.mtg

\\printl\public

This command copies the file MEMOO513.DOC from the olgar directory on the
humanr server, creating a file called ANNUAL.MTG in the public directory on the
printl server.

See Also
For more information about this command, see:
•

The NET MOVE command in this chapter, to learn how to move-rather than
copy-files.

•

The MS-DOS User Reference, for information about the MS-DOS COpy
command.
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NET HELP
This command provides information at the MS-DOS prompt about how to use
MS-DOS LAN Manager Enhanced commands. This information includes the Basic
commands, since these are also a part of MS-DOS LAN Manager Enhanced.

Syntax

(NET HELP) \

~

'-I command

!r-'

I

command may be any of the following MS-DOS LAN Manager Basic or Enhanced
commands:
ACCESS

COpy

LOOON
PASSWORD
SAVE
USE

ADMIN
WAD
MOVE
PAUSE
SEND
VIEW

CONTINUE
LOGOFF

NAME
PRINT
START

Do not type the word NET as part of command; it is assumed. NET HELP
provides help on the NET LOGOFF and NET LOGON commands; it does not
provide help on LOGON or LOGOFF.
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Comments

When used without options, the NET HELP command displays a list of all
MS-DOS LAN Manager commands. You can type NET HELP, followed by only
the second word of the MS-DOS LAN Manager command. For example, if you
want help in using the NET USE command, type:
net

help

use

In response, NET HELP displays information about the NET USE command:
The syntax of this command is:
NET USE [devicename I \\computername\sharename]
NET USE [devicename] \\computername\sharename [password]
NET USE {devicename I \\computername\sharename} /DELETE
The NET USE command connects a netstation's local devicename to a
server's shared resource.
See the MS-DOS LAN Manager User Reference for more information
about this command.

NOTE: You can also see help information for an MS-DOS LAN Manager
command by typing the command in the following form:
command

/help

For example, you could see information about the NET LOAD command by typing
either of the following commands:
net
net

help
load

load
/help
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You can type a command in the following fonn to see only infonnation about
syntax for that command:
command /?

For example, if you were interested in seeing only what the proper syntax for the
NET SEND command is, you could type:
net

send

/?

Example
To get lielp with options and syntax associated with the NET ADMIN command,
Mike types:
net

help

admin

See Also
For more infonnation about this command, see:
•

The NET HELP reference section earlier in this chapter, for the version of NET
HELP that displays the commands for MS-DOS LAN Manager Basic.
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NET LOAD
This command loads a specified profile file that contains MS-DOS LAN Manager
commands to configure the netstation's local area network connections.

Syntax
(

NET LOAD

)y~-.--- ....
drive: \path

--_._-_. .!
filename

r'

I

Option

Purpaie

drive:\path

Specifies the location of t~rofile file. If no drive letter and path
are specified, MS-DOS L
Manager Enhanced assumes the
profile file is located in the default directory
\3 open\doswksta\lanman\proJiles.

filename

Specifies the name of the profile file.

When used without options, the NET LOAD command loads the default profile file
\30PEN\DOSWKSTA\LANMAN\PROFILES\NETLOGON.PRO.
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Comments
The NET LOAD command loads a profile file for your netstation. A profile file is
like a batch file, containing NET USE commands that configure your netstation's
local area network connections.
The NET LOAD command cannot run if the Workstation service is not started. But
if you type the NET LOAD command before logging on to the Workstation service,
MS-DOS LAN Manager Enhanced offers to log you on to the netstation
automatically:
Workstation not started.
OK to start it? (Y/[N])

Type Y to log on to the Workstation service and load your profile file.
If any connections to shared resources exist when NET LOAD is used, MS-DOS
LAN Manager Enhanced prompts for confmnation before canceling the existing
connections and establishing the ones specified in the profile file. If any
connections are actually in use when you type the NET LOAD command, MS-DOS
LAN Manager Enhanced displays an error message and asks if you want to
continue. If you do, any existing connections are discontinued.

About Profile Files
By default, MS-DOS LAN Manager Enhanced assumes profile files are stored in
the directory \3open\doswksta\/anman\proji/es. Storing all profile files in one
directory makes it easy for users to create, find, and use profile files. MS-DOS
LAN Manager Enhanced also assumes a filename extension of .PRO, unless you
specify otherwise. From the MS-DOS prompt, you can use the NET SAVE
command to create a profile file. Typically, your network administrator will create
a default NETLOGON.PRO file on your netstation when the netstation is first
connected to the local area network. If you wish, you can later modify the default
profile to fit your specific needs.
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Example
Jenny is working on a new project this week and needs to use the printer in the
computer room. She uses the NET SAVE command to create a new profile file,
called NETPRINT.PRO, that connects her netstation to the line printer in the
computer room:
net

save

netprint.pro

Normally, Jenny has no need to use this printer, so she did not want to alter her
default NETLOGON.PRO file. When Jenny wants to print with the line printer,
she types:
net

10ad

netprint.pro

See Also

For more information about this command, see:
•

The NET SAVE command in this chapter, for information about creating profile
files.

•

The NET START command in this chapter, for information about how profile
files are loaded when the netstation is started.

•

The Load Configuration dialog box in Chapter 3: LAN Manager Screen
Reference, for information about loading profile files using the LAN Manager
screen.
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NET LOGOFF
This command ends a computer's connection with the 3+Open network and logs a
user name off from the 3+0pen network.

Syntax
(NET LOGOFF ) - - -....

Comments
The NET LOGOFF command is used to end a user's 3+0pen network session.
Since only one user at a time can be logged on to the local area network from a
netstation, logging off one user name frees the netstation for use by someone else.
NET LOGOFF only logs you off the 3+0pen network; you must use the LOGOFF
command, described at the beginning of this chapter, to log off the network if your
network includes the 3+Name service.
If you are actively using any shared resources (for example, your current drive is a
redirected drive), you must stop using the resources before you can log off. If you
have any connections to a server's shared resources when you use the NET
LOGOFF command, MS-DOS LAN Manager Enhanced warns you that logging off
deletes those connections. You are then asked to confrrrn your request to log off.
If you confirm your request, you will see the following message on your screen:
username
successfully logged off

Once the NET LOGOFF command has been completed, you no longer have an
active user name, password, or local area network session, and you cannot receive
messages sent to your user name.
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Example
At the end of the day, to log off from the local area network, Jenny types:
net

logoff

See Also
For more information about this command, see:
•

The LOGOFF command earlier in this chapter, for information about logging
from off mixed networks (networks that include the 3+Name service).

•

The NET LOGON command in this chapter, for information about logging on
to the 3+0pen network.

•

The Log Into Network dialog box in Chapter 3: LAN Manager Screen
Reference, for information about logging on to MS-DOS LAN Manager
Enhanced using the LAN Manager screen.
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NET LOGON
This command logs a user name on to MS-DOS LAN Manager Enhanced and sets
the user name and password for the user's netstation.

Syntax
(

NET WGON )

Option

~r---u-s-e:-n-a-m-e-V ~-p-a-s-~-wo-r-d-j71
Abbreviation

Purpose

username

Specifies the default user name for the local
netstation (up to 20 characters long).

password

SEecifies the ~assword for the netstation (up to
1 characters ong).

When used without options, NET LOGON prompts for both the user name and the
password.

Comments
The NET LOGON command establishes the user name and password that are used
by 3+0pen servers to validate requests to use shared resources. This command
logs you on to the 3+Open network; it does not log you on to any particular
3+0pen server.
NET LOGON works only with 3+0pen servers; you must use the 'LOGON
command, described earlier in this chapter, if your network includes the 3+Name
service.
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If your 3+0pen network uses logon security (by keeping a distributed or centralized
database of user names and passwords on one or more servers), then your user
name and password are sent to the server for verification. If the logon server
recognizes the user name/password combination you gave, you are allowed to log
on to the 3+Open network. If you have a logon script associated with your
account, MS-DOS LAN Manager Enhanced runs the script on your netstation when
you log on to the 3+Open network. (This script is contained in a file on the logon
server.)
When prompting for a user name, the NET LOGON command displays a default
user name. This name is taken from the username= entry of the LANMAN.INI
file. If this entry has no value, NET LOOON uses the computer name of the
net station (from the computemame= entry in the LANMAN.INI file) as the default
user name.
Instead of typing your password, you can type an asterisk (*). This causes
MS-DOS LAN Manager Enhanced to prompt you for your password. When you
type your password at the prompt, it is not displayed on the screen. This helps you
to keep your password confidential.
You can use the NET LOGON command at any time to change a netstation's user
name and password. To do this, simply type the NET LOGON command, along
with the new user name and password.
If someone is already logged on to the 3+0pen network from your netstation, the
NET LOOON command displays a prompt saying that that user name must be
logged off before another can be logged on.

The NET LOGON command also tries to add the specified user name as an alias for
the netstation. If the user name cannot be added as an alias, MS-DOS LAN
Manager Enhanced logs you on to the 3+0pen network, but displays a warning
message.
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Example

For Jenny to establish her user name,jennyt, and password, babaloo, as the default
on a netstation, she types:
net

1ogon

jennyt

baba100

If the netstation already had a default user name and password, Jenny would see the
following prompt:
You are currently logged on as USERl
You must logoff before logging on.
Proceed with logoff? (Y/[N]): Y
USERl logged off successfully
JENNYT logged on successfully.

She types Y for yes, and her user name and password become the default for the
netstation.

See Also
For more information about this command, see:
•

The LOGON command at the beginning of this chapter, for information about
logging on to mixed networks (networks containing the 3+Name service).

•

The NET LOGOFF command in this section of this chapter, for information
about logging off from the 3+0pen network.

•

The NET START WORKSTATION command in this chapter, for information
about specifying a user name and password when starting the netstation under
MS-DOS LAN Manager Enhanced.

•

The Log Into Network dialog box in Chapter 3: LAN Manager Screen
Reference, for information about logging on to the 3+0pen network using LAN
Manager Screen.
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NET MOVE
This command moves files, both locally and remotely.

Syntax
(

NET MOVE

)-.---1

pathnamel

I

Option

Purpose

pat~namel

Names the file(s) to be moved. This pathname can include
wildcard characters (* or ?).
Identifies the directory or filename of the file(s) to which
pathnamel will be moved. If pathname2 is not specified, the files
are moved to the current directory. If wildcard characters are used
in pathnamel, then pathname2 must be a directory.

pathname2

Comments

The NET MOVE command moves files between any two directories you have
permission to use. You can move files between two network computers. You do
not have to make connections to servers to move network files; the NET MOVE
command makes the connections for you.
Moving a file is not the same as copying a file. Copying makes a duplicate of the
specified file and leaves the original in place; moving relocates a file from one place
to another.
To move files, you must have create and delete permission for both the source files
and the destination directory.
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Example
To move all of the document files from the text directory on drive C of her
netstation to the \reports\budget directory on the general server, Olga types:
net

move

c:\text\*.doc

\\general\reports\budget

All of Olga's files that match the c:\texf\* .doc pathname are now on the \\general
server and have been deleted from Olga's c:\text directory.

See Also
For more information about this command, see:
•

The NET COpy command in this chapter, for information about copying fues.

•

The MS-DOS User Guide, for information about wildcard characters.
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NET NAME
This command displays, adds, or deletes the message aliases defined in a
net station's list of aliases.

Syntax
NET NAME

alias

Option

Purpose

alias

Specifies an alias you want to add or delete.

ladd

Adds an alias to the netstation.

Idelete

Removes an alias previously added to the netstation.

When used without options, the NET NAME command lists all of the aliases
currently active on the local netstation. For example:
Name

JIMMYW
WALTERK
GUEST
The command completed successfully.
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Comments

The NET NAME command is also available under MS-DOS LAN Manager Basic,
but under Basic it only lists the user name established at your netstation. Under
MS-DOS LAN Manager Enhanced, it provides many more options. These options
deal with aliases used for messaging. Therefore, the MS-DOS LAN Manager
Messenger service must be started before you use NET NAME to work with
aliases.
A netstation can have three types of names:
•

One computer name

•

One user name

•

One or more aliases

Your netstation can receive messages sent to all three types of names.
The fadd switch is optional (that is, fadd is assumed with no other options); you can
add a new alias by typing NET NAME, along with the alias without the fadd
option. Thus, the following two commands do the same thing, assuming jackst is a
new alias:
net
net

name
name

jackst
jackst

/add
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Example
Jimmy Wilson just started working in the mailroom. He wants Leslie to receive
messages for him, until he gets a netstation of his own. Leslie types the following
command at her netstation:
net

name

j immyw

Now Leslie's netstation is ready to receive all messages sent to jimmyw. When
Jimmy gets his own netstation, Leslie can stop receiving messages for him by
typing:
net

name

j immyw

/ delete

See Also
For more information about this command, see:
•

The NET SEND command in this chapter (if you have MS-DOS LAN Manager
Enhanced), for information about sending messages to other users.

•

The Aliases for Messaging dialog box in Chapter 3: LAN Manager Screen
Reference, for information about adding and deleting aliases using the LAN
Manager screen.
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NET PASSWORD
This command changes the password for accessing a 3+0pen server.

Syntax
nTP~SWO~k-------------------------------------------------------------------------------------'---------~

\ \comput ern ame

k-----------------------------------------------------------------I

Option

Purpose

computername

Names the server on which the password will be used.

username
old password

Names the user who has the password on the server.
Specifies the user's current password. (Your password can be
up to 14 characters long.) You can type an asterisk (*) instead
of your password to cause MS-DOS LAN Manager Enhanced
to prompt you for your password.
Specifies the user's new password. (Your password can be
up to 14 characters long.) You can type an asterisk (*) instead
of your password to cause MS-DOS LAN Manager Enhanced
to prompt you for your password.

new password
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When used without options, the NET PASSWORD command prompts you for all
the information it needs. The following prompts are displayed:
net password
Type the computername where you want to change a password,
or press ENTER if it is the local server
Type your user name:
Type the user's old password:
Type the user's new password:
Retype your password to confirm:
The command completed successfully.

Comments

The NET PASSWORD command changes the password for a user's account on a
particular server running with user-level security. This command cannot be used
for 3+0pen LAN Manager servers running with share-level security, or 3+ servers.
The NET PASSWORD command prompts for any option not typed on the
command line. If you type an asterisk instead of a password, MS-DOS LAN
Manager Enhanced prompts you for the password. When you type your password
at the prompt, it is not displayed on the screen. This helps you to keep your
password confidential.
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Example
When Jenny wants to change her password on the \\mis server from babaloo to
duwamps, she types:
net

password

\\mis

jennyt

babaloo

duwamps

If there is another person in her office when Jenny changes her password, she
types the NET PASSWORD command without options. This way, when she types
in her old and new passwords, they are not displayed on her screen.

See Also
For more information about this command, see:
•

The Change Logon Password at a Server dialog box in Chapter 3: LAN
Manager Screen Reference, for information about changing passwords using
the LAN Manager screen.
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NET SAVE
This command creates a profile file that defines the netstation's current local area
network connections for later use.

Syntax
(

NET SAVE

)

~'1

..

If..

. d
'
\ pat h _
r~ve:

_._!I
\filename

~

Option

Purpaie

drive:\path

Specifies the location of the profile file. If the drive letter and path
are not specified, MS-DOS LAN Manager Enhanced assumes that
the file is to be created in the default \3open\doswksta\projiles
directory.

filename

~pecifie~ the name of the profile file to contain the saved
mformatlon.

When used without options, NET SAVE stores the current local area network
configuration in the \30PEN\DOSWKSTA\PROFILES\NETLOOON.PRO file. If
the NETLOGON.PRO file already exists, MS-DOS LAN Manager Enhanced
displays this warning message:
The file you have chosen already exists.
Overwrite? (yIN) [N]:
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Comments
The NET SAVE command saves a profile of your netstation's current connections
to a profile file. A profile file is like a batch file that contains NET USE commands
that define your netstation's local area network connections. You can use the NET
LOAD command to load a profile file you save with the NET SAVE command.
When you do this, you reestablish the local area network connections defined by
the profile file.

About Profile Files
By default, MS-DOS LAN Manager Enhanced assumes profile files are stored in
the \3open\doswksta\projiies directory. Storing all profile files in one directory
makes it easy for you to create, find, and use profile files. MS-DOS LAN Manager
Enhanced also assumes a filename extension of .PRO, unless you specify
otherwise.
Typically, your network administrator will create a default NETLOGON.PRO file
on your netstation when the netstation is first connected to the local area network.
If you wish, you can later modify the default profile file to fit your specific needs.
Note that profile files have a different fonnat than batch files. Using a word
processing program, you can convert a profile file into a batch file. If you do so,
you should give the converted file the .BAT extension and use it as a batch file
rather than a profile file.
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Example
John O'Clare most often uses two shared directories: the shipping directory on the
\\printl server and the accounts directory on the \\billing3 server. He connects these
to his netstation's D: and E: device names, respectively. He also likes to use the
\\printl\dra!tprinter, which he links to his netstation's LPTI port. Once he has
connected to these shared resources, he saves the connections in the file
\BESTUSES.PRO by typing:
net

save

\bestuses.pro

The BESTUSES.PRO file contains the following commands:
net use d: \\printl\shipping
net use e: \\billing3\accounts
net use Iptl: \\printl\draft

When John wants to establish the connections defined in BESTUSES.PRO, he
uses the NET LOAD command to load this profile file.

See Also
For more infonnation about this command, see:
•

The NET LOAD command in this chapter, for infonnation about loading a
profile.

•

The Save Configuration dialog box in Chapter 3: LAN Manager Screen
Reference, for infonnation about saving a profile using the LAN Manager
screen.
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NET SEND
This command sends messages and files to other users.

Syntax
NET SEND

Option

Pur~e

alias

Specifies the,user name, group name, or computer name to which
die message IS to be sent.

<filename
"message"

Names the file to send as a message.
Specifies text to be sent as a message. Text must be contained
within quotation marks. This option and the <filename option are
mutually exclusive.
Indicates that all computers on the local area network are to receive
the message (a broadcast message).

*
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Comments

To send a short message to someone else on the local area network, type the NET
SEND command using the following form:
net

send

alias

"text"

The text of your message must be contained within quotation marks.
If the message you want to send is longer than one line, type the NET SEND
command and press [Return]. MS-DOS LAN Manager Enhanced will allow you to
type a message of any length; you may include several lines, including carriage
returns. When you have typed your message, press [Ctrl]+Z to add an end-of-file
character to your message. Then press [Return] again to send your message.
If you use the asterisk option to send a broadcast message (that is, a message sent
to all computers on the local area network), that message is limited to 128
characters. If you try to send a longer broadcast message, excess characters are
lost, and the receiver is not notified that the message is incomplete.
Files of up to 64 kilobytes can be sent as messages. However, most netstations
have only enough memory to receive files smaller than 2 kilobytes. (The size of a
netstation's message buffer is set by the sizmessbuf= entry in the LANMAN.INI
file or with the NET START MESSENGER /SIZMESSBUF:n command.) If you
send a message longer than the recipient can receive, the following error message
appears:
Message sent but not received

If you need to send a very long message file, a better alternative might be to store
the message file in a common area on a server, and then send a short message to the
recipient telling where to find the file.
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For you to successfully send a message to another person on the local area
network, the Messenger service must be running on both netstations. When your
message is successfully received, MS-DOS LAN Manager Enhanced displays the
following message:
Message successfully sent to username.

If you use an alias that MS-DOS LAN Manager Enhanced does not recognize, or if
the Messenger service is not running on the recipient's netstation, an error message
appears.

Example
To send a message to the group name pubrel, Debbie types:
net

send pubrel

"Meeting

changed to

3

p.m.

Same

place."

After the meeting, Debbie uses a word processor to type the meeting minutes. She
then sends the file as a broadcast message to all computers connected to the local
area network:
net

send

*

< notes. mtg

See Also
For more information about this command, see:
•

The NET NAME command in this chapter, for information about adding extra
aliases to your netstation.

•

The NET START MESSENGER command in this chapter, for information
about starting the Messenger service.

•

The Send a Message dialog box in Chapter 3: LAN Manager Screen, for
information about sending a message using the LAN Manager screen.
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NET START MESSENGER
This command starts the MS-DOS LAN Manager Enhanced Messenger service.

Syntax
NET START MESSENGER

----7'I

1ooIr-----I~-----,III"'"Ir"'---. . .

computername

Option

Purpose

computername

Specifies the computer name of your netstation.
Sets the size of the message buffer, in bytes. The maximum
size allowed is 62,000 bytes.

Isizmessbuf:n

NOTE: This command also accepts any options you can specify with the NET
START WORKSTATION command. See the NET START WORKSTATION
command in this chapter for a complete listing.

Comments

There are three services you may run on your netstation: Workstation, Netpopup,
and Messenger. The Messenger service allows you to send messages to others on
the local area network and to receive messages from them.
The services section of the LANMAN.INI file contains the pathnames for all of the
services.
NOTE: To start the Messenger service automatically when you start the
Workstation service, add Messenger to the services listed by the wrkservices= entry
in your LANMAN.INI file.
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Example
John wants to be able to send and receive messages over the local area network. To
start the Messenger service, he types:
net

start

messenger

See Also
For more information about this command, see:
•

The NET START WORKSTATION command in this chapter, for information
about starting the Workstation service.

•

The NET START NETPOPUP command in this chapter, for information about
starting the Netpopup service.

•

The NET SEND command in this chapter, for information about sending
messages to others on the local area network.

•

The NET NAME command in this chapter, for information about creating
aliases on your netstation.

•

The Message Menu and related dialog boxes in Chapter 3: LAN Manager
Screen Reference, for information about sending and receiving messages while
working from the LAN Manager screen.

•

The 3 + Open MS-DOS LAN Manager User Guide, for further instructions about
using the Messenger service.
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NET START NETPOPUP
This command starts the MS-DOS LAN Manager Enhanced Netpopup service.

Syntax
(NET START NETPOPUP

H

Comments
The N etpopup service is one of three services you may run on a netstation. The
other two are Workstation and Messenger. Before you can start the Netpopup
service, the Workstation service must be running. If you try to start the Netpopup
service first, MS-DOS LAN Manager Enhanced offers to start the Workstation
service first.
The Netpopup service displays messages sent to you via the local area network as
soon as they are received. Each message appears in a message box that is displayed
on top of the current contents of your screen. After you read your message, you
can press [Esc] to remove the message box from your screen.
The services section of the LANMAN.INI file contains the pathnames for all of the
services.

Example
John wants to see a message on his screen as soon as someone sends it. He types
the following to start the Netpopup service:
net

start

netpopup

2

MS-DOS LAN
Manager Command
Reference

2-86

See Also
For more infonnation about this command, see:
•

The NET START WORKSTATION command in this chapter, for information
about starting the Workstation service.

•

The NET START MESSENGER command in this chapter, for information
about starting the Messenger service.

•

The NET NAME command in this chapter, for infonnation about creating
aliases on your netstation.

•

The Message Menu and related dialog boxes in Chapter 3: LAN Manager
Screen Reference, for infonnation about sending and receiving messages while
working from the LAN Manager screen.

•

The 3 +Open MS-DOS LAN Manager User Guide, for further instructions on
using the Netpopup service.
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NET START WORKSTATION
This command starts the MS-DOS LAN Manager Workstation service and sets
other options for the netstation.

Syntax
NET START WORKSTATION ~----l"""--~P"IP--""--"'"

computername

computername is the name of the netstation.
options include one or more of the following:
Option

Specifies

/charcountbytes

Maximum amount of data stored by your
netstation before data is sent to a network pipe.
Increasing the amount of data increases local area
network efficiency, but may cause some delay in
character transmission.
Maximum interval that your net station stores data
before sending it to a network pipe.

Ichartime:milliseconds
/computemame:name
/himem: [yeslnoloptional]
/keepapis: [yeslno]

Computer name for your netstation.
Whether hi,h memory allocation is used by the
netstation. f this is selected, the netstation will
determine whether to utilize high memory.
Whether MS-DOS LAN Manager Enhanced
Application Program Interfaces (APIs) are
available to Aplications. If no is selected, only
named-pipe
Is are available.

2

MS-DOS LAN

Manager Command
Reference

2-88

Option

Specifies

/langroup:name

Name of the user's default LAN group. Your
LAN group determines which servers you can
see with the NET VIEW command.
Name of the root directory into which MS-DOS
LAN Manager software is stored.
Name of the server on which logon information
will be found. When centralized logon security
is used, name can be either a specific computer
name or\\* (\\* tells the netstation to search for
the centralized logon server).
Indicates whether mailslot delivery is
nonguaranteed.

/lanroot:name
/logonserver:name

Imailslots: [yeslno]
Inumcharbuf:nwnber

Number of character and pipe buffers.

Inummailslots:nwnber

Number of mailslots available.

Inumresources:nwnber

Maximum number of connections to shared
resources allowed on the net station at a time.
Maximum number of servers with which the
netstation can have active connections.

Inumservers:number
Inumviewbuffers:nwnber
Inumviewedservers:nwnber

Number of buffers available for receiving
information from a server.
Maximum number of servers that can be viewed
with the NET VIEW command.

Inumworkbuf:nwnber

Number of netstation buffers to allocate.

Ipr1 buffsize:bytes

Number of buffers available for printer
connection 1.
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Option

Specifies

/pr2buffsize:bytes

Number of buffers available for printer
connection 2.
Number of buffers available for printer
connection 3.

/pr3 buffsize:bytes
/sizcharbuf:bytes

Size of the character/pipe buffer.

/sizworkbuf:bytes

Size of each netstation buffer.

/wrkservices: list

Services that will start along with the netstation.

NOTE: The following switches are provided for compatibility with the NET
START WORKSTATION command in 3+:
Option

Specifies

/z:bytes /nbs:bytes

Size of netstation buffers.

IB:n/nbc:n

Number of netstation buffers.

Comments

NET START WORKSTAnON is available under both MS-DOS LAN Manager
Basic and MS-DOS LAN Manager Enhanced. However, under Enhanced the
command takes a number of options, the most important of which is
computername. The options portion of the command allows you to temporarily
override the internal operating settings of MS-DOS LAN Manager Enhanced.
Normally, this will not be necessary; these settings, contained in your netstation's
LANMAN.INI, were selected by your network administrator during installation as
the ones appropriate for your network. If you believe any of these options should
be changed, consult your network administrator.
If computername is not specified with the NET START command, the computer
name listed in the computername= entry of the LANMAN.INI file is used.

2
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For convenience, the NET START WORKSTATION command is inserted into
your workstation's AUTOEXEC.BAT file by the 3+Open MS-DOS LAN Manager
setup program.
All options that work with the NET START WORKSTATION command also work
with the NET START MESSENGER command (provided you have MS-DOS LAN
Manager Enhanced), if the netstation is not yet started.

Example
John has removed the NET START WORKSTATION line from his
AUTOEXEC.BAT file. When John arrives at the office in the morning, he turns
on his computer and types the following command to start the Workstation service:
net

start

workstation

To start his netstation with a different computer name, John could type:
net

start

workstation

/computername:john_oclare
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NET VIEW
This command displays the computer names of all 3+Open network servers in your
LAN group or, alternately, the resources being shared by a 3+0pen server.

Syntax

(NET VIEW)

\1

~

_ \ \ cornputernarne

~I
_

Option

Purpaie

\'computername

Specifies the server whose shared resources you want to view.

When used without options, the NET VIEW command displays the computer
names of all servers visible on the local area network. For example:
Server Name

Remark

\\MIS
\\PRINTl
\\PRINT2

Mary Sullivan's office
Printer room, first floor
Printer room, second floor

The command completed successfully.
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Comments
The NET VIEW command is provided so that you can see:
•

Which 3+Open servers in your LAN group are available for you to use.

•

Which resources are shared with the local area network by each available
3+0pen server.

NET VIEW will not display 3+ servers.
Once you know the computer name of a 3+0pen server, you can type the NET
VIEW command followed by the server's computer name to see what resources the
3+0pen server is sharing with the local area network. For example:
net view \printl
Resources at \PRINTl
Printer room, first floor
Net Name

Type

Used as

Remark

PRT
FAST PRT

Print
Print
Disk

LPT2
LPTl
R:

Printer pool
High priority printer
Drive D Root

D

The command completed successfully.

This display shows:
Column

Contents

Net Name

Sharename of a shared resource.

Type
Used as

Type of resource being shared.
Your netstation's local device name that is currently redirected to
this shared resource.

Remark

Descriptive comment about the resource.

MS-DOS LAN

Manager Command
Reference

2
2-93

Example
To see the computer names of the servers available in her LAN group, Jenny types:
net

view

One of the servers listed is \\mis. To see the resources being shared by \\mis,
Jenny types:
net

view

\ \mis

Now that she knows the computer name of the server and what it is sharing, Jenny
can use the NET USE command to actually connect to \\mis and use its shared
resources.

See Also
For more information about this command, see:
•

The NET USE command in this chapter, for information about using a resource
shared by a server.

•

The Servers Available on Network dialog box in Chapter 3: LAN Manager
Screen Reference, for information about using the LAN Manager screen to see
the computer names of available 3+0pen servers.
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Chapter 3: LAN Manager Screen
Reference
With the LAN Manager screen, you use menus and dialog boxes to perform
MS-DOS LAN Manager Enhanced operations. The LAN Manager screen is only
available to users running MS-DOS LAN Manager Enhanced. H you are using the
Basic version of MS-DOS LAN Manager, LAN Manager Screen is not available to
you, and you can only use Basic commands; those commands are documented in
Chapter 2: MS-DOS LAN Manager Command Reference.
This chapter contains individual reference pages that describe how to use the menus
and dialog boxes of the LAN Manager screen.

3
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This chapter includes the following infonnation:
•

U sing the LAN Manager screen and its menus, dialog boxes, and help facility

•

Reference pages for the View menu and related dialog boxes

•

Reference pages for the Message menu and related dialog boxes

•

Reference pages for the Config menu and related dialog boxes

For more infonnation about how to use the MS-DOS LAN Manager Enhanced
menus and dialog boxes, see the 3+0pen MS-DOS LAN Manager User Guide.
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Using the LAN Manager Screen
To display the LAN Manager Screen, type the following command at the MS-DOS
prompt:
net

Your screen will look something like this:
View Message Config
, - - - - - - - - - Microsoft DOS LAN Manager 1.13
Your llSerna[lle:
I1ARYS
Your cO[llputerna[lle:
"INVEST
13 network files are open.

Press He ALT

ke~

to select a [lIenu

Figure 3-1. LAN Manager Scregn

Fl=Help
-------~
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The LAN Manager screen includes the following elements:
•

Menu bar, which lists the names of all LAN Manager screen menus, and a
special item, Fl=Help.

•

Action area, which provides infonnation about your netstation, and provides a
place for menus, dialog boxes, help boxes, and message boxes to be displayed.

•

Message line, which provides a short description of the selected option.

Netstation Information
The LAN Manager screen includes the following display fields:
Field

Description

Your usemame
Your computemame

Name you used to log on.
Name of your netstation. A com~uter name is always
preceded with two backslashes ~ ).
Nqmber of local area network files you are currently
USIng.

# network files are open
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Logging On
The Log Into Network dialog box appears automatically when you start the
LAN Manager Screen, if you are not already logged on.
View
Message ~
Fl=Help
, - - - - - - - - Microsoft DOS LAN Manager 1.8 - - - - - - - - - ,
Your usernaJlle:
(not logged in)
Your cOJllputernaJlle:
\\INVEST
8 network files , - - - - - Log Into Network - - - - - ,
UsernaJlle . . . . [............... .. ]
Password . . . . [ ................. ]

(

OK

}

(Cancel}

Log on to the local-area network

Figure 3-2. Log Into Network Dialog Box
This dialog box allows you to log on to the 3+0pen network or to set your user
name and password. Once your user name and password are set, you can access
resources such as printers and files on the local area network.
The Log Into Network dialog box only logs you on to the 3+0pen network. You
must use the LOGON command, described in Chapter 2: MS-DOS LAN Manager
Command Reference, to log on to a network that contains the 3+ Name service.
For complete information about this dialog box, see the Log Into Network dialog
box reference page.
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Selecting Menus and Menu Items
You can use either the keyboard or a mouse to select menus and items from menus.
Your mouse must be either a Microsoft mouse or a compatible mouse. To select an
item using the mouse, simply move the mouse pointer to the item and click on it.
To view a menu using the keyboard, press [AIt], followed by the first letter of the
menu name. A menu appears below the menu name. For example, if you press
[Alt]+V, the View menu appears:
I!Im!I
r-

Message

Config
M'Icroso rt DOS LAN Manager 1 B
Network servers, , .
MARYS
This workstation ...
\\INVEST

Fl=Help

Print queues ...
Exit

F3

View local-area network Servers

Figure 3-3. View Menu
A menu contains one or more options, called menu items. Except for the Exit menu
item, any menu item you select leads to a dialog box. Use the cursor keys or the
mouse to select a menu item. (To exit the LAN Manager screen, select the View
menu and choose the Exit menu item.)
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Using Help
You can use the LAN Manager screen help facility to get more infonnation about an
option you have selected. When you press [FI] (or click on the FI=Help item in
the menu bar using the mouse), a help box like that shown here displays
information about the task that you are performing:
View

l1essage

Config
Fl=Help
l1icrosoft DOS LAN l1anager .8 - - - - - - - - - - - - ,
Your usernaMe:
I1ARYS
Your cOMputernaMe:
\ \ INVEST
About the LAN l1anager Screen (Page 1 of 1)
8 11
The LAN l1anager Screen is divided into three parts:
•
•
•

l1enu bar -) View I1sg Conf
Fl
MS-DOS LAN l1anager 1.8
Action
area -----)
l1essage
line -----) Press the Alt key to select a Menu.

The I1ENU BAR lists tile naMes of the available Menus.
The ACTION AREA
I
shows inforMation about your Workstation or a Server.
I
displays Menus, dialog boxes, help, and message boxes.
The I1ESSAGE LINE displays help about the selected option.
<Next (PgDn»

<Back (PgUp»

<Index)

<Cancel)

Press the ALT key to select a menu

Figure 3-4. Help Box
Help is context-sensitive, meaning that it provides you with infonnation about what
you are doing. For example, if you select the This netstation menu item and press
[FI], a help box appears, showing infonnation about how to use this option. If
you have not selected a menu, menu item, or dialog box, Help displays general
infonnation about the LAN Manager screen.
By selecting the Index command button from any help box, you can see the Help
index. From the Help index, you can choose to see infonnation about other topics.
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Using Dialog Box Elements
When you choose a menu item, a corresponding dialog box appears:
, - - - - - - Change Logon Password at a Server ---------.
Visible servers
BOBPA
CYNTHIAH
LILAS
NETUE

t
~il

j

t'

Servernal"le .

[ ...... .

. ....... ]

Usernal"le . .

[MARYS· .

. ....... ]

Old password
New password

[ .................... ]
[ .................... ]

'----------'

< OJ( > <Cancel}

Figure 3-5. Sample Dialog Box
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Dialog boxes include one or more elements. The following lists all possible dialog
box elements and how to use them:

Element

How to use it

List box

Use the cursor keys to select a list box item.

Text box

Type in information, or select information from a list box.

Command button
Option button

Use [Tab] to select a command button.
Use the cursor keys to mark (enable) one option button in a
set.

Check box

Use the [Space bar] to mark or unmark a check box.

Display field

Contains information only; cannot be selected or changed.

Each dialog box reference page in this chapter identifies the dialog box by:

•

Name

•

Series of options you must select to access it

•

Access paths

The access path for a dialog box is documented in this form:

Menu -> Menu Item -> Command Button

3
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This path shows how to reach the dialog box by selecting a series of options.
Options are separated by arrows. For example, a typical access line might look like
this:

View -> Print queues -> Zoom
In other words, to get to this dialog box, you would perform these steps:

1.

Select the View menu.

2.

Choose the Print queues menu item.

3.

From the dialog box that appears, choose the Zoom command button.
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Menus and Dialog Boxes in This Chapter
The remainder of this chapter contains reference pages for the LAN Manager screen
menus and dialog boxes shown in the following list. Note that menus and dialog
boxes are arranged in this chapter according to access path.
The following list shows the access path and name of each menu and dialog box
documented in this chapter:

Select

To see •••

View

View menu
Servers Available on Network
Resources at <Server>
Use the resource <Network Path>
Network Resources in Use at Your Workstation
Use a Network Resource
Accessing <Network Path>
U sage Information for a Network Resource
Show Print Queues For
Print Queues for <Server>
Print Options for Job
Printing Options for Queue
Message menu
Send a Message
Aliases for Messaging
Add an Alias
Config menu
Log Into 3+0pen Network
Log Off From the 3+0pen Network
Load Configuration
Save Configuration
Change Logon Password at a Server

->Network servers
->Zoom
->Use
->This netstation
->Add use
->OK
->Zoom
->Print queues
->Zoom
->Zoom
->Zoom

Message
->Send
->Aliases
->Add alias

Config
->Logon
->Logoff
->Load profile
->Save profile
->Change password

3
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View Menu
The View menu items let you use dialog boxes that provide you with information
about resources on the local area network. Some of these dialog boxes show the
resources being shared by servers. Others show the status of the resources you are
using.
A resource can be a printer queue or a disk directory that can be shared by a server
on the local area network.
The View menu has four items, three of which are described in detail on the next
several pages. Each menu item displays several dialog boxes; these are explained in
the section on the menu item which displays them.
The last item on the View menu is labeled Exit [F3]. Use this menu item (or press
[F3]) to exit the MS-DOS LAN Manager screen.

View -> Network Servers
This menu item displays the Servers Available on Network dialog box. This dialog
box shows the names and comments for 3+0pen servers that are part of your
network. From here you can:
•

Select the computer name of a 3+0pen server to list its shared resources.

•

Type the computer name of any 3+ server on the network to list its shared
resources.

•

Use a shared resource from a server.

•

Stop using a shared resource.
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Servers Available on Network
Access: View -> Network servers
The Servers Available on Network dialog box shows the servers available on the
local area network. These servers can control resources such as disks and printer
queues. If a server is sharing resources, you can use a shared resource by
redirecting a local device name to the network resource. Select the name of a server
and the Zoom command button to see a list of resources being shared by a particular
server.

IIm!II

Message

Config
M'Icrosoft DOS LAH Manager 1 0
Your usernal'lle:
MARYS
Your computername:
\\IHVEST

Fl=Help

Servers Available on Hetwork

0
Servernal'lle

[ .............................. ]

Visible server Rel'llark
DOBPA
CYHTHIAH
LILAS
HETUE

Dob Papsdorf 112104
C~nthia Hunsaker 1/2097
112090 User Education server

t
.1·1

j~il
:!;:

l.
I

< ZOOI'll >

< Done >

•

View local-area network Servers

Figure 3-6. Servers Available on Network Dialog Box
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This dialog box contains one list box with two columns:

Column

Contents

Visible server

Computer names of all visible servers.

Remark

Descriptive comment about each server.

The other elements of the dialog box are:

Servemame

Specifies the computer name of a server that you want to display
more information about.

Zoom

Displays the Resources at (Server) dialog box.

Done

Exits the dialog box and returns to the LAN Manager screen.

Listing a Server's Resources
To see detailed information about a particular server, follow these steps:
1.

Select the computer name of the server from the list box, or type in the
server's computer name in the text box.

2.

Choose the Zoom command button.
The Resources at (Server) dialog box appears.
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Resources at (Server)
Access: View -> Network servers -> Zoom
The Resources at (Server) dialog box shows the shared resources controlled by a
server. It shows the name of the shared resource, device type, redirected device
name, and a comment about the server. With this dialog box, you can use or stop
using a network resource.
~

F1=Help

Message

Config
l1'lcrosoft DOS LAN l1allager 1 8
Your userna[l1e:
l1ARYS
Your cO[l1puterna[l1e:
"INVEST
Servers Available Oil Network
Seruerna[l1e ["NETUE· ...................... ]
Resources at "NETUE
1/2898 User Education server

B

-

-

I

Sharena[l1e

Type

DA-PRT
KAOS
LPT12B98
SCRATCH
SLl1D
SLMP

Printer
Printer
Printer
Disk
Disk
Disk

Used as

II

Re[l1ark
QMS PS158B for DA's
Ql1S PS158B for NETUE ...
Ql1S PS1588 public queue
Scratch directory for ...

< Use > < Un-use >

View local-area network Seruers

Figure 3-7. Resources at (Server) Dialog Box

t
llH

Iii!

t'
< Done >
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This dialog box contains one list box with four columns:
Colunm

Contents

Sharename
Type

Name of each shared resource controlled by the server.
Ty'pe of resource shared. A shared resource can be a disk or a
pnnter.
Local device name linked to the shared network resource. (If
you have more than one local device name connected to a
shared network resource, the first local device name, followed
by ellipses [...], appears here.)
Descriptive comment about the shared resource.

Used as

Remark

The other elements of this dialog box are:
Use

Displays the Use the resource (network path) dialog box.

Un-use

Disconnects the local device name from the network resource.

Done

Returns to the servers Available on Network dialog box.
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Using a Network Resource
To use a network resource, follow these steps:

1.

From the list box, select the name of the resource.

2.

Choose the Use command button.
The Use the Resource (Network Path) dialog box appears. The Local device
text box may display a default device name.

3.

Type the device name you want and the password (if necessary) and choose
the OK command button to connect your local device name to the shared
resource.

Stop Using a Network Resource
To stop using a network resource, follow these steps:

1.

From the list box, select the name of the resource.

2.

Choose the Un-use command button.
A message box appears, asking you to confinn your decision:
(DO

3.

you wish to stop using \\server\sharename?)

Choose the OK command button to disconnect your local device name from
the shared resource.

3
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Use the Resource (Network Path)
Access: View -> Network servers -> Zoom -> Use
The Use the Resource (Network Path) dialog box allows you to use a shared
resource on a server. Depending on the type of shared resource you selected before
entering this dialog box, a default local device name may appear in the first edit
field.
F1=Help
I!Im!I l1essage Config
. - - - - - - - - - - - - Microsoft DOS LAN l1anager 1.B - - - - - - - - - - - ,
Your usernallle:
I1ARYS
Your cOlllputernallle:
\\IMVEST
B

Servers Availahle on ttetwork - - - - - - - - - - - ,
Servernallle [\\ttETUE····················· .. ]
, - - - - - - - - - - Resources at \\ttETUE - - - - - - - - - , . 1
1I2B96 User Education server
Sharenallle

Type

Used as

Relllark

DA-PRT
Printer
QttS PS15BB for DA's
K.----- Use the resource \\ttETUE\LPT12B9B -------,
L
QttS PS15BB puh lie queue
S
S
S

Local device [LPT1·]
Password . . [ ................. ]

1'----

>

View local-area network Servers

Figure 3-8. Use the Resource (Network Path) Dialog Box
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This dialog box contains the following elements:
Local device

Specifies the name of a local device name you selected to be
redirected to the shared device (drive: for disk devices; LPT# for
printers). More than one local device name-separated by commas
(,), semicolons (;), or spaces-may be specified here.

Password

Provides a place for you to type a password for the shared
resource, if required. A server requires passwords when sharelevel security is running. A password is also required if you did
not specify a password when logging on and this is the fIrst shared
resource to which you are connecting.

OK

Redirects the local device name to the shared resource.

Cancel

Exits the dialog box without redirecting to the resource, and returns
to the Shared Resources at (Server) dialog box.

Connecting to a Shared Resource
To use the selected shared resource, follow these steps:
1.

Type the local device name (for example, E: or LPT2:) in the Local device text
box.
MS-DOS LAN Manager Enhanced typically suggests an available local device
name for you to use. You may accept the default device name or type in
another device name.

2.

If needed, type the password in the Password text box.

3.

Choose the OK command button.

3
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View -> This Workstation
This menu item displays the Network Resources in Use at Your Workstation dialog
box. This dialog box shows all shared resources the local netstation is using.
From here, you can:
•

Get more information about one of your netstation's current connections.

•

Temporarily pause the use of shared printers from your netstation.

•

Add a connection to a network resource.

•

Delete a connection to a network resource.
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Network Resources in Use at Your Workstation
Access: View -> This workstation
The Network Resources in Use at Your Workstation dialog box shows the local
device names for the shared resources that you are using, listed according to the
local device name that you have assigned to the shared resource. From this dialog
box, you can add or delete a resource, or see more information about it.

I!m

Fl=Help

Message

Config
Microsoft DOS LAN Manager 1.B
Your usernaMe:
MARYS
\\INVEST
Your cOlilputernallle:
Network Resources in Use at Your Workstation
Device

Making use of

T:

\\THEBOZ\LANMAI't

Relilark

~

;i

I
[

] Pause using printers

< Add use > < ZOOIil > < Delete>

< Done >

•

View resources used

b~ ~our

workstation

Figure 3-9. Network Resources in Use at Your Workstation Dialog Box
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This dialog box contains one list box with three columns:
Column

Contents

Device
Making use of

Local device name.
Network path of the shared resource (in the format

Remark

\\server\resource).

Descriptive comment about the resource.

The remaining elements of this dialog box are:
Pause using
printers

Suspends redirection of local device names to shared resources and
frees them for local use.

Add use

Displays the Use a Network Resource dialog box.

Zoom

Displays the Usage Information for a Network Resource dialog box.

Delete

Disconnects a local device name from a shared resource.

Done

Exits the dialog box and returns to the LAN Manager screen.

Adding a New Connection
To connect to a new shared resource, follow this step:
1.

Choose the Add use command button.
The Use a Network Resource dialog box appears, allowing you to use the
shared network resource you specify.
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Deleting a Connection
To disconnect a local device name from a shared resource, follow these steps:

1.

Select the device name from the list box.

2.

Choose the Delete command button.

Getting More Information About a Network Resource
To get more information about a network resource, follow these steps:

1.

From the list box, select the name of the network resource.

2.

Choose the Zoom command button.
The Usage Information for a Network Resource dialog box displays detailed
information about the selected local device.

3
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Use a Network Resource
Access: View -> This workstation-> Add use
The Use a Network Resource dialog box allows you to connect one of your local
device names (such as LPTI or Z:) to a shared network resource.

I!m!I

Message

Config
M'lcrosoft DOS LAN Manager 1 B
Your usernaMe:
MARYS
Your cOlllputernallle:
\\INVEST

Fl=Help

Network Resources in Use at Your Workstation
Device
I

Making use of

ReMark
I

t

Use a Network Resource
Type of Use

I

(.)
(

)

Disk
Printer

( )

Deviceless use

I

I
~

I--

lD: - - -]
Local device
Network resource [ - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - ]
[ - - - - - - - - - - - - - - - - -]
Password

L---

I

< OK

>

~

Done
<Cancel>

View resoorces used by your workstation

Figure 3-10. Use a Network Resource Dialog Box

>
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Local device

Specifies the name of the local device name to be redirected
to the shared resource. The default is the next available
device name (drive: for directories; LPT# for printer
queues).

Option Buttons

This dialog box includes three option buttons:
Button

Function.

Disk

Specifies that you want to use the local
device name to connect to a directory.

Printer

Specifies that you want to use the local
deyice name to connect to a spooled
pnnter queue.
Allows you to connect to a network
resource without redirecting a local
device name.

Deviceless use

Network resource

Specifies the network path of the network resource (use the
format \\server\resource).

Password

Specifies a password for the shared resource (if the resource
requires a password).

OK

Redirects the local device name to the network resource.

Cancel

Exits the dialog box and returns to the Network Resources in
Use at Your Workstation dialog box without redirecting the
shared resource.

3
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Connecting to the Network Resource
To connect a local device name to a shared resource, follow these steps:
1.

Select the Disk, Printer, or Deviceless use option button.
MS-DOS LAN Manager Enhanced finds the first available local device name
for the device type you select and displays that device name in the Local
device text box. (No device name is displayed if you select Deviceless use.)

2.

In the Local device text box, type in a new device name (such as E: or LPT2:)
if you want to assign another local device name to the network resource.

3.

In the Network resource text box, type the network path of the shared
resource. A network path includes the name of the server and the shared
resource in the format \'t;erver'resource.

4.

If the server or shared device requires a password, type the password in the
Password text box.

5.

Choose the OK command button.
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Accessing (Network Path)
Access: View -> This workstation-> Add use -> 0 K
NOTE: The network path consists of the name of a server followed by the name of
a resource, in the fonnat \\server\resource.
The Accessing (Network Path) dialog box appears if you do not specify a password
when connecting to a network resource that requires a password. This dialog box
asks you to supply a password for the resource specified.
~ Message
Config
Fl=Help
. - - - - - - - - - - - Microsoft DOS LAN Manager l.B - - - - - - - - - - - ,
Your usernaMe:
MARYS
Your cOlllputernallle:
\\IHVEST

r - - - - - - Network Resources in Use at Your Workstation - - - - - - ,
Device
D:

Making use of

ReMark

L- ~P_:

IY

E:

~a~_~w_~-_~d_<

T_l_ ..._::_:_e:_U_:_S_::_:_:d__[a______

< Add

I
~-l>--I~

, - - - - Accessing \\MOLLY\C-MARIOJ - - - - ,

use

> <

ZOOIll

> < Delete >

t

__-O-K_--_}_---<c-.-nc-·

Done

View resources used by !;lour workstati"ol1
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Enter
password

Provides a place for you to type the password for the network
resource. This is not the same as your logon password.

OK

Redirects your local device name to the shared resource if the
password you typed is correct.

Cancel

Exits the dialog box and returns to the Use a Network Resource
dialog box.

Supplying a Password
To specify a password for a network resource on an MS OS/2 LAN Manager server
running with share-level security, follow these steps:
1.

Type in the password.

2.

Choose the OK command button.
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Usage Information for a Network Resource
Access: View -> This workstation -> Zoom
The Usage Information for a Network Resource dialog box displays infonnation
about a local device name connected to a shared network resource. The local device
name can be a disk or a printer queue.
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Figure 3-12. Usage Information for a Network Resource Dialog Box
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Local device

Displays the local device name assigned to the resource (drive: for
directories; LPT# for printer queues).

Network
resource

Displays the path of the network resource (in the format
\\servenresource).

Status

Displays the status of the local device name. The status can be OK,
Disconnected, Error, Connecting, or Reconnecting.

Remark

Displays a descriptive comment about the network resource.

Done

Returns to the Network Resources in Use at Your Workstation
dialog box.

View -> Print Queues
This menu item displays the Show Print Queues For dialog box. This dialog box
lists all visible servers and the printer queues they own. It also lists all of your
netstation's local device names that are connected to printer queues. From here,
you can:
•

List the contents of a printer queue connected to a local device name.

•

List the printer queues made available by a specific server.

•

List the options of a printer queue.

•

Modify the status of your print job.
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Show Print Queues For
Access: View -> Print queues
The Show Print Queues For dialog box lists the names of 3+Open LAN Manager
servers in your LAN group and the printer queues each is sharing with the local
area network.
This dialog box also shows local device names that are redirected to shared printer
queues. From this dialog box, you can select the name of a queue and choose the
Zoom command button to see more information about a particular queue.
~
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Figure 3-13. Show Print Queues For Dialog Box
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Servemame

Specifies the computer name of the server you want more
information about.

Visible servers

Lists all visible 3+0pen LAN Manager servers in your LAN
group.

Redirected devices

Lists all of the local device names linked to printer queues.

Zoom

Displays the Print Queues for (Server) dialog box. (You
must have access permission for a server to see information
about its shared printer queues.)

Done

Exits the dialog box and returns to the LAN Manager screen.

Listing a Server's Printer Queues
To list all printer queues shared by a server, follow these steps:
1.

2.

Specify the computer name of the server by doing one of the following:
•

Select the computer name of the server from the Visible servers list box.

•

Type in the name of the server in the Servername text box.

Choose the Zoom command button.
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Print Queues for (Server)
Access: View -> Print queues -> Zoom
The Print Queues for (Server) dialog box shows the printer queues on a server. It
also shows the jobs in each printer queue and the status of each queue and job.
The status of a printer queue can be listed as OK, Held, Held until, Pending delete,
or Error. The status of a print job can be listed as Spooling, Held, Printing on
(device), Held on (device), Out of paper on (device), Error on (device), Offline on
(device), or Waiting.
Printer queues are listed in order of priority. Printer queues with lower numbers
have higher priority. Jobs in printer queues with high priority are printed before
jobs in printer queues with low priority. From this dialog box, users can hold or
restart their printjob(s). Administrators can also hold or continue a queue.
~
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Figure 3-14. Print Queues for (Server) Dialog Box
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This dialog box contains a list box with four columns:

Column

Contents

Name

Name of the printer queue or owner of the print job.

Job #

Identification number assigned to the print job.

Size

Size (in bytes) of the print job.

Status

Status of the printer queue or job.

The other elements of this dialog box are:

Hold

Holds the selected print job in the printer queue so it does not print.

Release

Releases the job from its held state.

Zoom

Displays either the Printing Options for Job or Printing Options for
Queue dialog box and shows detailed information about the selected
item.

Delete

Removes only your selected print job(s).

Done

Exits the dialog box and returns to the Show Print Queues For
dialog box.

Changing the Status of Your Print Job
To change the status of print jobs you own, follow these steps:

1.

Select the job from the list box.

2.

Choose one of the following command buttons:
•

Hold, to hold the job in the queue and not print it.

•

Release, to allow a held job to be sent to the printer.

•

Delete, to remove the print job so that it won't be printed.
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Getting More Information About a Job or Queue
To learn more about a print job or a printer queue, follow these steps:

1.

Select the print job from the list box.

2.

Choose the Zoom command button.
The Printing Options for Queue dialog box appears.

3.

When you are finished reading the information, choose the OK command
button.
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Printing Options for Job
Access: View -> Print queues -> Zoom -> Zoom
The Printing Options for Job dialog box displays printing options for a selected job.
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Job #

Displays the print job's current position in the queue.

Usemame

Displays the name of the user who submitted the job for
printing.

Sharename

Displays the name of the printer queue containing the job.

Size

Displays the size (in bytes) of the print job.

Status

Displays the status of the print job.

Minutes in queue

Displays the length of time the print job has been in the printer
queue.

Minutes printing

Displays the length of time the print job has been printing.

Printing on

Displays the name of the printer.

Remark

Provides a space for you to type a description of the print job.
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Printing Options for Queue
Access: View -> Print queues -> Zoom -> Zoom
The Printing Options for Queue dialog box displays information for a printer queue.
Printer queue options affect how the queue sends print jobs to its printers.
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Sharename

Displays the name of the printer queue.

Status

Displays the status of the printer queue.

Priority

Specifies the priority setting for the printer queue. The highest
priority is 1; the lowest is 9. The default is 5.

Printer device(s)

Specifies the names of the one or more printers to which the
printer queue can spool print jobs. Multiple device names are
separated by semicolons (;), commas (,), or spaces.

Separator file

Specifies the name of the file that contains the print job
separator page. The printer queue prints this page following
each print job.

Print after

Specifies the time of day (in the format hh:mm, in which 1:30
p.m. would appear as 13:30) the printer queue is to begin
spooling print jobs to printers. The default is 00:00.

Print until

Specifies the time of day (in hh:mm format) after which the
printer queue no longer spools print jobs. The default is
23:59.

Print processor

Specifies the name of the print preprocessor (a program that
prepares certain document files for the printer).

Parameters

Specifies different parameters used by the print preprocessor.

Comment

Provides a description of the printer queue.

Done

Exits the dialog box and returns to the Print Queues for
(Server) dialog box.
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Message Menu
The Message menu items let you use the MS-DOS LAN Manager Messenger
service. The Messenger service allows you to send messages over the local area
network. The Message menu also lets you add or delete aliases that are used in
messaging.
The Message menu has two items, which are described on the following pages.

Message -> Send
Selecting Send from the Message menu displays the Send a Message dialog box.
In it, you can designate the recipient(s) of your message, and compose a short text
message or designate a file to send.

LAN Manager
Screen Reference

3
3-41

Send a Message
Access: Message -> Send
The Send a Message dialog box allows you to send a message or file to a user on
the local area network. The user's alias identifies the destination of your message.
If your message is short (less than 255 characters), you can type your message in
the space provided. Or, you can use a text editor to create a message file.
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Figure 3-17. Send a Message Dialog Box
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There are several elements in this dialog box:
To

Select from two options to specify the recipient:

Option

Function

Name

Sends the message to the alias you type in
the Name text bOx.

All LAN users

Broadcasts the message to all users on the
local area network.

Name

Specifies the user who is to receive a message or file. You
may identify only one recipient.

Send

Specifies the type of message you are sending:

Button

Function

Message text

Sends the message you type in the
Message text text box.
Sends the messaee contained in the file
specified in the ontents of file text box.

Contents of file
Message text

Specifies the message text. You may type up to 255
characters. For a local area network-wide broadcast, the
message may be up to 128 characters.

Contents of file

Specifies the pathname of a file you want to send.

Files in (directory)

Lists the names of files in the current directory. If you specify
a wildcard character (* or ?) in the Contents of file text box
and choose the OK command button, this list box displays
filenames that match the wildcard search.
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Other drives/dirs

Lists the names of disks and directories containing possible
message files. Selecting an item changes the contents of the
Message filename text box. When you select an item from this
list box and choose the OK command button, the contents of
the Files in (directory) list box change.

OK

Sends the message or file to the specified recipient(s) and
returns to the LAN Manager screen.

Cancel

Exits the dialog box without sending the message or file, and
returns to the LAN Manager screen.

Sending a Message
To send a message to one or more users of the local area network, follow these
steps:

1.

Specify the recipient(s) of your message by selecting one of the To option
buttons.

2.

Identify the type of message you want to send.

3.

If you want to send a short message, select the Message text option button
and type your message.

4.

If you are sending the contents of a file, select the Contents of file option
button and specify the filename.
NOTE: If you select the Contents of file option button and use a wildcard
character (? or *) in the Contents of file text box, a list of files that match the
wildcard search appears in the Files in (directory) list box when you choose
the OK command button.
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Message -> Aliases
Selecting Aliases from the Messages menu displays the Aliases for Messaging
dialog box, which displays aliases currently in effect on your netstation. From this
dialog box, you can add or delete aliases.

Aliases for Messaging
Access: Message -> Aliases
The Aliases for Messaging dialog box lists aliases for users currently permitted to
receive messages at this computer. You can add or delete an alias from the list.
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Figure 3-18. Aliases for Messaging Dialog Box
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This dialog box contains one list box with one column:
Column

Contents

Alias

Message aliases of users permitted to receive messages.

The other elements of this dialog box are:
Add alias

Displays the Add an Alias dialog box.

Delete

Removes the selected message aliases from the list of users
permitted to receive messages.

Done

Exits the dialog box and returns to the LAN Manager screen.

Adding an Alias
To add a new alias to your netstation, follow these steps:
1.

Choose the Add alias command button.
The Add an Alias dialog box appears.

2.

Type the message alias in the text box.

3.

Choose the OK command button.

Deleting a Message Alias
To delete an alias from the list of names that can receive messages at your
netstation, follow these steps:
1.

Select the alias from the list box.

2.

Choose the Delete command button.
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Add an Alias
Access: Message -> Aliases -> Add alias
The Add an Alias dialog box allows you to add a message alias to the list of users
allowed to receive messages at this netstation. UntH a user's alias is on this list, the
user cannot receive any type of message at this netstation.
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Alias

Specifies the message alias of a user. This can be an established user
name or any other alias for which this netstation should receive
messages.

OK

Adds the specified alias to the list of users permitted to receive messages
and returns to the Aliases for Messaging dialog box.

Cancel

Exits the dialog box and returns to the Aliases for Messaging dialog box
without making changes to the list of aliases allowed to receive
messages.
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Config Menu
The Config menu items give you access to MS-DOS LAN Manager Enhanced
configuration dialog boxes. Config, short for Configuration, refers to the
connections your netstation makes to local area network resources. The Config
dialog boxes let you save and load sets of connections, called profiles. From this
menu, you can also log on to or log off from the local area network, and change
your password.
There are five items on the Config menu. They are explained on the following
pages.

Config -> Logon
Selecting Logon from the Config menu displays the Log Into Network dialog box,
in which you enter your user name and password.
NOTE: This method logs you on to the 3+0pen network only; it does not log you
on to the 3+ network, or the 3+Name Service, if you are operating in a mixednetwork environment. You must use the LOGON command, described in Chapter
2, to log ori to a mixed network.
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Log Into Network

Access: Config -> Logon
NOTE: If you are not already logged on, this dialog box appears automatically
when you start the LAN Manager screen by typing NET.
The Log Into Network dialog box allows you to log on to the local area network.
You can use this dialog box to set your user name and password. Once your user
name and password are set, you can access resources such as printers and files on
the local area network.
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Username

Specifies your user name for the local netstation. If your
LANMAN.INI file contains your user name, it is proposed as the
default name. User names can be up to 20 characters long.

Password

Specifies your password. Note that MS-DOS LAN Manager
Enhanced makes no distinction between uppercase and lowercase
letters for user names and passwords. Passwords can be up to 14
characters long.

OK

Logs on to the local area network and returns you to the LAN
Manager screen.

Cancel

Exits the dialog box and returns to the LAN Manager screen. If you
accessed this dialog box when you fIrst started the LAN Manager
screen, the Cancel command button returns you to the MS-DOS
prompt.

Logging on to MS-DOS LAN Manager
When you establish a session on the local area network, the net station supplies your
user name to the network server. Servers require all netstations requesting a
session to supply the user name of the current user.
To log on to MS-DOS LAN Manager Enhanced, follow these steps:

1.

At the MS·DOS prompt, type NET; or from the LAN Manager screen, select
the Config menu and choose the Logon menu item.

2.

In the Use rna me text box, type your user name, if necessary.

3.

In the Password text box, type your password, if necessary.

4.

Choose the OK command button.
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Config -> Load Profile
This menu item displays the Load Configuration dialog box. From here you can
load a profile file into the netstation. This file typically includes a set of NET USE
commands that configures your netstation by connecting your netstation to network
resources on the local area network.

Load Configuration
Access: Config -> Load profile
The Load Configuration dialog box loads a set of configuration parameters from a
file.
Configurations are stored in profile files containing NET USE commands. These
profile files are normally stored in the \3open/doswksta\projiles directory and
typically include a filename extension of .PRO. The default configuration flie is
NETLOGON.PRO.
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Once you load a profile file with the Load Configuration dialog box, the netstation
fIrst deletes all current connections and then runs each local area network command
in the profile file. The netstation uses all of the resources defined by the profile file.
If MS-DOS LAN Manager Enhanced has a problem running any command in the
file, an error message is displayed.
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Filename

Specifies the pathname of the profile file to load.

Files in (directory)

Lists the files in the \\3open\doswksta\profiles directory. If
you specify a wildcard character (* or ?) in the Filename text
box and choose the OK command button, this list box
displays filenames that match the wildcard search.

Other drives/mrs

Lists the disk drives and directories on your computer.
Selecting a drive or directory changes the contents of the
Filename text box. When you select an item from this list
box and choose the OK command button, the contents of the
Files in (directory) list box change.

OK

Loads the specified configuration file into the netstation and
returns to the LAN Manager screen.

Cancel

Exits the dialog box without loading a file and returns to the
LAN Manager screen.

Loading a Profile
To load a profile file for your netstation, follow these steps:

1.

From the Files in (directory) list box, select the filename.

2.

If needed, from the Other drives/mrs list box, select a different directory.

3.

Choose the OK command button.
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See Also
For more information about configuration commands, see:
•

The Save Configuration dialog box in this chapter, for information about
loading a profile file with the LAN Manager screen.

•

The NET USE command in Chapter 2: MS-DOS LAN Manager Commands,
for information about connecting to a shared resource.

•

The NET SAVE and NET LOAD command in Chapter 2: MS-DOS LAN
Manager Commands, for information about saving and loading netstation
configurations to and from a profile file.

•

The 3 + Open MS-DOS IAN Manager User Guide, for information about saving
or loading a configuration file.

Config -> Save Profile
This menu item displays the Save Configuration dialog box. This allows you to
store the netstation's current configuration as a profile file.
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Save Configuration
Access: Config -> Save profile
The Save Configuration dialog box saves a list of the netstation's current local area
network connections to a specific profile file.
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Filename

Specifies the pathname of the profile file.

Files in (directory)

Lists the files in the \3open\doswksta\projiles directory. If
you specify a wildcard character (* or ?) in the Filename text
box and choose the OK command button, this list box
displays file names that match the wildcard search.

Other drives/dirs

Lists the disk drives and directories on your computer.
Selecting an item in this list box changes the contents of the
Filename text box. When you select an item from this list
box and choose the OK command button, the contents of the
Files in (directory) list box change.

OK

Stores the server's current configuration to the specified file
before exiting the dialog box and returning to the LAN
Manager screen.

Cancel

Exits the dialog box and returns to the LAN Manager screen
without saving the configuration to the profile file.

Saving Your Current Configuration
To save a list of your netstation's current local area network connections to a profile
file, follow these steps:

1.

2.

Specify the filename of the profile in one of two ways:
•

Type the name of the file in the Filename text box.

•

Select the name of an existing file from the Files in (directory) list box.
The contents of this file will be replaced with the new profile information.

Choose the OK command button.
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See Also
For more infonnation about configuration commands, see:
•

The Load Configuration dialog box in this chapter, for information about
loading a profile file with the LAN Manager screen.

•

The NET USE command in Chapter 2: MS-DOS LAN Manager Commands,
for information about connecting to a shared resource.

•

The NET SAVE and NET LOAD commands in Chapter 2: MS-DOS LAN
Manager Commands, for information about saving and loading netstation
configurations to and from a profile file.

•

The 3+0pen MS-DOS IAN Manager User Guide, for information about saving
or loading a configuration file.

Config -> Change password
This menu item displays the Change Logon Password at a Server dialog box.
From here you can change your password on a 3+0pen server.

Change Logon Password at a Server
Access: Config -> Change password
The Change Logon Password at a Server dialog box changes your account's
password on a network or local server running with user-level security. To change
your password, you must have an account on the server. It is a good idea to
change passwords regularly; this makes it difficult for other users to log on in your
place and use your account without your authorization.
NOTE: You can only change your logon password on a 3+0pen server using this
method. You must use the LOOON command at the MS-DOS prompt if you want
to change your password on a 3+ network using the 3+Name service.

3
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NOTE: If you try to change your password on a 3+Open LAN Manager server
running with share-level security, an error message displays. This is because these
servers do not maintain user passwords.
Fl=Help
View
Message ~
, . . - - - - - - - - - - Microsoft DOS LAN Manager 1.8 - - - - - - - - - ,
Your user naMe :
MARYS
Your cOMputernaMe:
"INVEST
13 n e . . - - - - - - CJlange Logon Password at a Server - - - - - ,
Visible servers
Server naMe .

[ - ------

UsernaMe . .

[MARYS - - - - - - - - - - - - - - - ]

i:l: Old password .

[ - -- - - - - - --- - - - -- - ---]
[ --- -- --- - - -- - - - - - -- -]

t

OOOPA
CHRISDR
CYNTHIAH
LILAS
HETUE
L....-_ _ _ _

i
---li

Hew password .

-- - - - -- - - ----]

< OJ(

CJlange

~our

>

<Cancel>

password at a Server

Figure 3-23. Change Logon Password at a Server Dialog Box

Visible servers

Lists the names of all servers for the network.

Servemame

Displays the name of the server selected from the Visible servers
list box. You can also type the name of the server here.

Usemame

Specifies your user name. If you are currently logged on to
MS-DOS LAN Manager Enhanced, your user name
automatically appears in this text box.

Old password

Specifies the old password to your account.
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New password

Specifies the new password to your account.

OK

Changes your password and returns to the LAN Manager
screen.

Cancel.

Exits the dialog box without changing your password, and
returns to the LAN Manager screen.

Changing Your Password
To change your password on a server, follow these steps:
1.

From the Visible servers list box, select the server, or type the name in the
servemame text box.

2.

In the Username text box, type your user name, if necessary.

3.

In the Old password text box, type your current password.

4.

In the New password text box, type the new password.

5.

Choose the OK command button.

See Also
For more information about passwords, see:
•

The Log Into Network reference page, for information about using a password
to log on to a netstation.

•

The 3 + Open MS-DOS IAN Manager User Guide, for information about using
a password to access server resources.
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Appendix A: Error Messages
This appendix shows all error messages that can be displayed on your screen by
DOS LAN Manager.

LOGON/LOGOFF Error Messages
LOOOOOO:
LOOOOOl:
LOOOO02:
LOOOO03:
LOOOO04:
LOOOO05:
LOOOO06:
LOOOO07:
LOGOO08:
LOOOO09:
LOOOOI0:
LOOOO 11:
LOOOOI2:
LOGOO 13:
LOOOO 14:
LOOOO 15:

Incorrect parameter
Incorrect parameter value
Incorrect redirector version
Redirector not loaded
Network is not installed
Internal error
Incorrect password
Access denied
Sharename not found
Network name not found
Duplicate name on network
Computer name already in use
Unable to set redirector name
Insufficient memory
Unable to delete messenger names
Unable to add messenger name
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LooOO16:
LooOO17:
LooOO18:
LooOO19:
LooOO20:
LooOO21:
LooOO22:
LooOO23:
LooOO24:
LooOO25:
LooOO26:
LooOO27:
LooOO28:

Unable to link. Drive is already redirected
Unable to link. This is a local drive
Execution stopped by the user
Computer name not defined
Must use DOS 3.0 or greater
The device is being used by an active process
You are not currently logged on
DOS error
User abort
Invalid 3+Name Service user name
operation did not complete
Already logged on
User name not found

3+Name Service Error Messages
Loo0100:
Loo0101:
Loo0102:
Loo0103:
Loo0104:
LooO 105:
Loo0106:
Loo0107:
Loo0108:
Loo0109:
Loo0110:
LooO 111:
Loo0112:
Loo0116:
LooO 117:
LooOl18:
LooOl19:
Loo0120:
Loo0121:
Loo0122:

Unknown error.
OS error.
No such organization.
No such domain.
No such name.
Domain is remote.
Alias' name doesn't exist.
Domain is remote for alias' name.
No such domain or org for alias' name.
Alias points to an alias.
Directory bad.
Name index bad.
Property index bad.
Property not found.
Property not defined.
Not item property.
Not group property.
Invalid property.
Property already exists.
Property doesn't exist.
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LOO0123:
LOO0124:
LOO0125:
LOO0126:
LOG0136:
LOO0137:
LOG0138:
LOG0139:
LOG0145:
LOG0146:
LOO0147:
LOO0148:
LOO0149:
LOO0150:
LOO0151:

Value already exists.
Max properties.
No such property.
No space for property.
Name not found.
Incorrect password.
Inadequate capability.
Inappropriate credentials.
Invalid organization.
Invalid domain.
Invalid name.
Too busy.
Use courier.
Other error.
Reject.

LOO1300:
LOO1304:
LOO1306:
LOO1307:
LOO1308:
LOO1312:
LOO1313:
LOO1314:
LOO1343:
LOO1344:
LOO1345:
LOG1353:
LOG1357:
LOO1358:

Cancelled.
Cancelled.
A value is required.
Password too large.
Bad name.
Cache error.
Please login first.
No user logged in.
Enter Yes or No.
LGL not loaded.
LGL not loaded.
Error getting address.
Can't unlink device(s).
<device> is being accessed by an active process
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General LAN Manager Errors
NET2102:
NET2103:
NET2104:
NET2105:
NET2106:
NET2107:
NET2109:
NET2114:
NET2115:
NET2116:
NET2117:
NET2118:
NET2119:
NET2121:
NET2123:
NET2127:
NET2131:
NET2134:
NET2136:
NET2138:
NET2139:
NET2140:
NET2141:
NET2142:
NET2143:
NET2146:
NET2147:
NET2149:
NET2150:
NET2151:
NET2152:
NET2154:

The Workstation driver NETWKSTA.SYS is not installed.
The Server cannot be located.
An internal error occurred. The network cannot access a shared
memory segment.
A network resource shortage occurred.
This operation is not supported on Workstations.
The device is not connected.
This UNC sharename does not exist.
The Server has not been started.
Requested item does not exist.
The device or directory does not exist.
Redirected devices cannot be shared.
The name has already been shared.
The Server is currently out of the requested resource.
Requested add of item exceeds maximum allowed.
The API return buffer is too small.
A remote API error has occurred.
An error occurred when opening or reading LANMAN.INI.
An internal error occurred when calling the Workstation driver.
A generic network error has occurred.
The Workstation service has not been started.
The requested Server information is not available.
An internal LAN Manager error has occurred.
The Server is not configured for transactions.
The requested API is not supported on the remote Server.
The event name is poorly formed.
The program could not find the specified component in
LANMAN.INI.
The program could not find the specified parameter in LANMAN.INI.
A line in LANMAN.lNI is too long.
The printer queue does not exist.
The print job does not exist.
The printer destination cannot be found.
The printer queue already exists.
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NET2155:
NET2156:
NET2157:
NET2158:
NET2159:
NET2160:
NET2161:
NET2163:
NET2164:
NET2165:
NET2180:
NET2181:
NET2182:
NET2183:
NET2184:
NET2185:
NET2186:
NET2187:
NET2188:
NET2189:
NET2190:
NET2191:
NET2200:
NET2201:
NET2202:
NET2203:
NET2204:
NET2205:
NET2206:
NET2207:
NET2210:
NET2211:

No more printer queues can be added.
No more print jobs can be added.
No more printer destinations can be added.
This printer destination is idle and cannot accept control operations.
This printer destination request contains an invalid control function.
The printer processor is not responding.
The Spooler service has not been started.
This operation cannot be performed on the printer queue in its current
state.
This operation cannot be performed on the print job in its current state.
A Spooler memory allocation failure has occurred.
There is a timeout on the service table semaphore.
The service table is full.
The requested service has already been started.
There is a service entry semaphore timeout.
The service has not been started.
The service name is invalid.
The service is not responding to the control function.
The service control is busy.
LANMAN.INI contains an invalid service program name.
The service cannot be controlled in its present state.
The service would not respond to normal service control functions and
was stopped with the DosKillProc function.
The requested pause or stop is not valid for this service.
This Workstation is already logged on.
This Workstation has not been logged on yet.
The usemame or groupname parameter is invalid.
The password parameter is invalid.
The logon processor did not add the message alias. (Warning
message.)
The logon processor did not add the message alias. (Error message.)
The logoff processor did not delete the message alias. (Warning
message.)
The logoff processor did not delete the message alias. (Error
message.)
A centralized logon Server conflict has occurred.
The Server is configured without a valid user path.
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NET2212:
NET2213:
NET2214:
NET2215:
NET2220:
NET2221:
NET2222:
NET2223:
NET2224:
NET2225:
NET2227:
NET2228:
NET2229:
NET2230:
NET2232:
NET2234:
NET2236:
NET2237:
NET2250:
NET2251:
NET2252:
NET2270:
NET2271:
NET2272:
NET2273:
NET2274:
NET2275:
NET2276:
NET2277:
NET2278:
NET2279:
NET2280:
NET2281:
NET2282:
NET2283:
NET2284:

An error occurred while loading or running the logon script.
The network is unable to use the resources provided for centralized
logon.
The logon Server was not specified. Standalone logon will occur.
The logon Server cannot be found.
The groupname cannot be found.
The username cannot be found.
The resource name cannot be found.
The group already exists.
The user account already exists.
The resource permission list already exists.
The server is not running with user-level security.
There are too many names in the access control file.
A disk I/O failure has occurred.
There were too many lists specified.
The parent directory cannot be located.
This operation is not allowed on this special group.
The user already belongs to this group.
The user does not belong to this group.
The connection cannot be found.
This asg_type is invalid.
This device is already being shared.
A computername has not been configured.
This message Server has already been started.
The message Server initialization request has failed.
The message alias cannot be found on the local-area network.
This message alias has already been forwarded.
This message alias has been added but is still forwarded.
This message alias already exists locally.
The maximum number of added message aliases has been exceeded.
The computername cannot be deleted.
Messages cannot be forwarded back to the same Workstation.
The log file or device has not been specified.
The message has been sent but the reception is currently paused.
The message was sent but not received.
The message alias is currently in use. Try again later.
The Messenger service has not been started.
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NET2285:
NET2286:
NET2287:
NET2288:
NET2289:
NET2291:
NET2294:
NET2295:
NET2297:
NET2298:
NET2310:
NET2311:
NET2312:
NET2314:
NET2315:
NET2316:
NET2317:
NET2318:
NET2319:
NET2331:
NET2332:
NET2333:
NET2334:
NET2335:
NET2337:
NET2338:
NET2340:
NET2341:
NET2342:
NET2343:
NET2351:
NET2354:
NET2356:
NET2357:
NET2362:

The name is not on the local computer.
The forwarded message alias cannot be found on the network.
The message alias table on the remote station is full.
Messages for this alias are not currently forwarded.
The broadcast message was truncated.
The log name contains invalid characters.
This is an invalid device.
A write fault has occurred.
A duplicate message alias exists on the local-area network.
This message alias will be deleted later.
This shared resource does not exist.
This device is not shared.
A session does not exist with that computername
There isn't an open file with that ID number.
A failure occurred when executing a remote administration command.
A failure occurred when opening a remote temporary file.
The data returned from a remote administration command has been
truncated to 64K bytes.
This device cannot be shared as both a spooled and a non-spooled
device.
The Server table was initialized incorrectly.
The operation is invalid for this device.
This device cannot be shared.
This device was not open.
This device name string is invalid.
The queue priority is invalid.
There are no shared communication devices.
A queue doesn't exist for this request.
This list of devices is invalid.
The requested device is invalid.
This device is already in use by the spooler.
This device is already in use as a communications device.
This computername is invalid.
The string and prefix specified are too long.
This path component is invalid.
Cannot determine type of input.
The buffer for types is not big enough.
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NET2370:
NET2371:
NET2372:
NET2373:
NET2374:
NET2377:
NET2380:
NET2381:
NET2382:
NET2383:
NET2385:
NET2389:
NET2391:
NET2392:
NET2400:
NET2401:
NET2402:
NET2403:
NET2404:
NET2405:

Profile files cannot exceed 64K bytes.
The start offset is out of range.
The system cannot delete current connections to network resources.
The system was unable to parse the command line in this file.
An error occurred while loading the profile file.
This log file exceeds the maximum defined size.
The source path cannot be a directory.
The source path is illegal.
The destination path is illegal.
The source and destination paths are on different servers.
The Run Server you requested using the NET RUN command is
paused.
An error occurred when communicating with a run Server.
An error occurred when starting a background process.
The shared resource you are connected to could not be found.
The LAN adapter number is invalid.
There are open files on the connection.
Active connections still exist.
This netname or password is invalid.
The device is being accessed by an active process.
The drive letter is in use locally.
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Alerter Service Messages
NET2430:
NET2431:
NET2432:
NET2433:

The Alerter service has already been started.
The Alerter service table is full.
The Alerter service has not been started.
The Alerter service recipient is invalid.

Net Service Messages
NET3051:
NET3052:
NET3053:
NET3054:
NET3055:
NET3056:
NET3057:
NET3058:
NET3059:
NET3060:
NET3061:
NET3062:

LANMAN.INlor the command line has an illegal value for
<variable> .
The required parameter <variable> was not provided on the command
line or in LANMAN.INI.
The unknown parameter <variable> was provided on the command
line or in LANMAN .IN!.
A request for <variable> resources could not be satisfied.
A problem exists with the system configuration: <variable>.
A system error has occurred.
An internal consistency error has occurred.
LANMAN.INI or the command line has an ambiguous parameter
<variable>.
LANMAN.INI or the command line has a duplicate parameter
<variable>.
The service did not respond to control and was stopped with the
DosKillProc function.
An error occurred when loading the service.
The sub-service <variable> failed to install.
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Command Syntax Messages
NET3500:
NET3501:
NET3503:
NET3505:
NET3506:
NET3507:

Server is not configured for administration.
An invalid switch was used.
The command contains an invalid number of arguments.
A switch was used with an invalid argument.
The switch <variable> is unknown.
The switch <variable> is ambiguous.

DOS LAN Manager Application Error Messages
NET3710:
NET3711:
NET3712:
NET3713:
NET3714:
NET3715:
NET3716:
NET3717:
NET3718:
NET3719:
NET3720:
NET3721:
NET3722:
NET3723:
NET3724:
NET3725:
NET3726:
NET3727:
NET3728:
NET3729:
NET3730:
NET3731:
NET3732:
NET3733:

There was an error opening the help file.
The help file is empty.
There is an error in the help file syntax.
An error occurred while sending a message.
An error occurred while opening a temporary file.
An error occurred while writing a temporary file.
The device type is unknown.
The log file has been corrupted.
Program file names must end with .EXE.
A matching share could not be found so nothing was deleted.
The device type is unknown.
The password is invalid for <variable>.
An error occurred while sending a message to <variable>.
An error occurred while opening a temporary file.
An error occurred when writing a temporary file.
An error occurred when the share was deleted.
The usemame is invalid.
The password is invalid.
The passwords do not match.
The profile could not be loaded.
This computemame is invalid.
The command was not found at the remote Server.
Default permissions cannot be set for that resource.
The NETRUN command looks for the program name on the runpath.
You cannot specify path characters when using NETRUN.

Error Messages

A
A-11

NET3734:
NET3735:
NET3736:
NET3737:
NET3738:
NET3739:
NET3740:
NET3741:
NET3742:
NET3744:
NET3745:
NET3746:
NET3747:
NET3748:
NET3749:
NET3750:
NET3751:
NET3752:
NET3753:
NET3754:
NET3755:
NET3757:
NET3800:
NET3801:
NET3802:
NET3803:
NET3804:
NET3805:
NET3806:
NET3807:
NET3808:
NET3809:
NET3810:
NET3811:
NET3812:
NET3813:
NET3850:

A valid password was not entered.
A valid name was not entered.
The resource named cannot be shared.
The permissions string contains invalid permissions.
This operation is only valid on LPT and COM devices.
<variable> already has rights for the resource.
<variable> has no rights for the resource.
<variable> is an invalid rights string.
<variable> is an invalid usemame or groupname.
A failure occurred while starting CMD.EXE.
An error was encountered processing the file <variable>.
<variable> is an invalid source file.
<variable> is an invalid destination file.
An error occurred while copying <variable>.
An error occurred while deleting <variable>.
An error occurred while moving <variable>.
An error occurred while searching a directory.
No users are logged on to this Server.
User <variable> is not a member of group <variable>.
User <variable> is already a member of group <variable>.
There is no such user: <variable>.
No valid response was provided.
This command line option is invalid.
This schedule update is invalid.
This schedule date is invalid.
The LANMAN root directory is unavailable.
The SCHED.LOG cannot be cleared.
Server shared memory cannot be accessed.
The AT job ID does not exist.
The schedule file is corrupted.
The delete failed due to a problem with the schedule file.
The command line cannot exceed 128 characters.
The schedule file cannot be updated because the disk is full.
The command line option is invalid.
The AT schedule file is invalid. Clear it and create a new one.
The AT schedule file was cleared.
Usage: growacc new-number-of-users.
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NET3851:
NET3852:
NET3853:
NET3854:
NET3855:
NET3856:
NET3857:
NET3858:
NET3859:
NET3860:
NET3861:
NET3862:
NET3863:
NET3864:
NET3865:
NET3866:
NET3867:
NET3868:
NET3869:
NET3870:

The new number of users argument is too big.
The new number of users must be numeric.
NET.ACC cannot be opened.
NET.ACC is not valid -- please reload from backup.
ACCESS.NET cannot be created.
Writing the signature to USERS.NET failed.
Writing to USERS.NET failed.
There are more active users in the old accounts file than in the new.
The accounts file was configured too small.
Re-encryption of password failed.
Writing to NET .ACC failed.
Reading from new accounts file failed.
The new NET.ACC is full.
Reading from NET .ACC failed.
Writing to NEWNET.ACC failed.
Renaming NET.ACC failed.
Renaming the old NET.ACC to BAK.ACC failed.
The update was destroyed. Please restore from backup.
Renaming NEW.ACC to NET.ACC failed.
<variable> is not a valid computemame.
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3+Open network
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ending session, 2-65
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NET ACCESS command and, 2-48
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Alerter service error messages, A-9
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deleting, 2-72, 3-46
display all, 2-72
for messaging, 3-45
application error messages, A-I0 to A-12
asterisk (*) option, 2-7
AUTOEXEC.BAT file
LOGON command and, 2-16
NET START WORKSTATION cOlnmand and, 2-92
automatic logon, 2-5
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Basic See MS-DOS LAN Manager Basic
Basic commands
summarized, 2-11
bubble diagrams
defined, 2-9

C
command option
abbreviations for, 2-4
command syntax
defined, 2-9
error messages, A-I 0
commands
abbreviations, 2-3
asterisk (*) option with, 2-7
Basic, summarized, 2-11
displaying all, 2-26, 2-60
Enhanced,summarized,2-41
LOGOFF, 2-12
LOGON, 2-14
NET, 2-43
NET ACCESS, 2-45
NET ADMIN, 2-51
NET CONTINUE, 2-23
NET COPY, 2-55
NET HELP, 1-6, 2-25, 2-59
NET LOAD, 2-62
NET LOGOFF, 2-65
NET LOGON, 2-67
NET MOVE, 2-70
NET NAME, 2-28, 2-72
NET PASSWORD, 2-75
NET PAUSE, 2-29

commands (continued)
NET PRINT, 2-31
NET SAVE, 2-78
NET SEND, 2-5, 2-81
NET START MESSENGER, 2-84
NET START NETPOPUP, 2-86
NET START WORKSTATION, 2-35, 2-88
NET USE, 2-36
NET VIEW, 2-93
Config menu, 3-49
Change password item, 3-58
Load profile item, 3-52
Logon item, 3-49
Save profile item, 3-55
configuration
loading, 3-52
saving, 2-78, 3-55
connection
adding new, 3-22
deleting, 2-36, 3-23
ending, 2-38
getting information about, 2-37

D
default configuration file, 3-52
device name
connect to shared resource, 3-26
redirecting, 2-36
showing local, 3-21
dialog box
access path, 3-11
Accessing (Network Path), 3-27
Add an Alias, 3-47
Aliases for Messaging, 3-45
Change Logon Password at a Server, 3-58
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dialog box (continued)
elements defined, 3-9
Help, 3-7
how to reach, 3-10
Load Configuration, 3-52
Log Into Network, 3-5, 3-50
Network Resources in Use at Your Workstation, 3-21
Print Queues for (Server), 3-33
Printing Options for Job, 3-37
Printing Options for Queue, 3-39
Resources at (Server), 3-15
Save Configuration, 3-56
Send a Message, 3-42
Servers Available on Network, 3-13
Show Print Queues For, 3-31
Usage Information for a Network Resource, 3-29
Use a Network Resource, 3-24
Use the Resource (Network Path), 3-18

E
Enhanced See MS-DOS LAN Manager Enhanced
Enhanced commands
summarized, 2-41
error messages
3+Name service, A-2 to A-3
Alerter service, A-9
application, A-I0 to A-12
command syntax, A-I0
defined, 1-8
general LAN Manager, A-4 to A-8
LOGOFF command, A-I
LOGON command, A-I
Net service, A-9
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F
files
copying, 2-56
moving, 2-70

H
help
with LAN Manager screen, 1-7, 3-7

L
LAN Manager error messages, A-4 to A-8
LAN Manager screen
components of, 3-4
display fields, 3-4
menu bar, 3-4
opening, 2-43, 3-3
local area network
copying files over, 2-56
displaying shared resources, 2-93
ending session, 2-12, 2-65
logging on, 1-3
logging on example, 1-4
saving current configuration, 2-78
servers available on, 3-13
viewing resources on, 3-12
logging on
automatically, 2-5
from Config menu, 3-49
options, 2-15
to 3+Name service, 2-21
to 3+0pen network, 2-20, 2-67
to mixed networks, 2-18, 2-22
LOGOFF command, 2-12
error messages, A-1
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LOGON command, 2-14
error messages, A-I
password, 2-17

M
menu
Config, 3-49
Message, 3-41
namessunnnarized,3-11
View, 3-12
menus and menu items
selecting, 3-6
Message menu, 3-41
Aliases item, 3-45
Send item, 3-41
messages
error, A-I to A-12
sending, 2-82, 3-42, 3-44
Messenger service, 1-3,2-84
starting automatically, 2-5, 2-84
mixed network
defined, 2-18
moving files, 2-70
MS-DOS LAN Manager
defined, 1-1
MS-DOS LAN Manager Basic
commands, about, 1-5
conunandssummarized,2-11
defined, 1-2
starting, 1-3
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MS-DOS LAN Manager Enhanced
automatic logon, 2-5
commands summarized, 2-41
defined, 1-2
logging on to, 3-51
screen, 1-5
starting, 1-3 '
See also LAN Manager screen

N
NET ACCESS command, 2-45
NET ADMIN command, 2-51
NET command, 2-43
NET CONTINUE command, 2-23
NET COPY command, 2-55
NET HELP command, 1-6, 1-7, 2-25,2-59
NET LOAD command, 2-62
NET LOGOFF command, 2-65
NET LOGON command, 2-67
logon security, 2-68
NET MOVE command, 2-70
NET NAME command, 2-28, 2-72
NET PASSWORD command, 2-75
NET PAUSE command, 2-29
NET PRINT command, 2-31
NET SAVE command, 2-78
NET SEND command, 2-5, 2-81
Net selVice error messages, A-9
NET START MESSENGER command, 2-84
NET START NETPOPUP command, 2-86
NET START WORKSTATION command, 2-35, 2-88
NET USE command, 2-36
NET VIEW command, 2-93
NETLOGON.PRO file, 3-52
Netpopup service, 1-3, 2-86
and Workstation selVice, 2-86
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netstation
names, 2-73
setting options, 2-88
network path
accessing, 3-27
network resource
connecting to, 3-26
dialog box, 3-24
displaying, 2-93
getting more information, 3-23
reinstating, 2-24
network resources
stop using, 3-17
using, 3-17
no option, 2-8

p
password
assigning, 1-3
changing, 2-21, 2-75, 3-58, 3-60
for MS OS/2 LAN Manager, 3-28
securi ty, 2-7
typing, 2-6
using with commands, 2-6
pathname
display all, 2-47
permissions
changing, 2-45
displaying, 2-47
types of, 2-49
print job
changing status, 3-34
options, 3-37
status, 3-33
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printer queue
displaying infonnation, 2-32
listing all shared by server, 3-32
listing infonnation, 3-36
options, 3-39
status, 3-33
profile
loading, 3-52, 3-54
profile file
defined, 2-63
loading, 2-63
saving current configuration, 3-57
storing, 2-79
PROFILE.SYS file, 2-19

R
remote connections
LOGON command and, 2-18
resources
connecting to network, 3-26
listing a server's, 3-14
using or stopping, 3-15

S
server
displaying resources, 3-15
displaying shared resources, 2-47
listing infonnation, 3-14
printer queues, 3-30
service names
abbreviations and synonyms, 2-3
services
reinstating, 2-24
starting automatically, 2-4
suspending, 2-29
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shared resource
add a connection, 3-22
connecting a local device, 3-26
connecting to, 3-19
delete a connection, 3-23
logging off, 2-13
show local device names, 3-21
use resource dialog box, 3-18

T
three-part name, 2-17

U
user name
default, 2-68
displaying, 2-28
logging on, 2-17

V
View menu, 3-12
Network servers item, 3-12
Print queues item, 3-30
This workstation item, 3-20

W
wildcard character (* or ?), 3-43, 3-44
Workstation service, 1-3
setting options, 2-90
show shared resources, 3-20
starting, 2-35, 2-88
starting automatically, 2-4
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V
yes option, 2-8
with LOGOFF command, 2-12

Z
Zoom button
displaying resources with, 3-14
information about a queue, 3-31
information about local device, 3-23
reaching dialog box with, 3-10
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Reader Comment Form

3Com Corporation

Please take the time to complete this form. Your suggestions and comments will help us to
improve our future publications. Thank you.
Part #: 5148-00
Publication: 3+0pen MS-DOS LAN Manager
User Reference
Please rate the product's documentation in each of the following areas:
Excellent

Technical Accuracy
Does the documentation reflect the product's functionality?

Good

Fair

Poor

D

D

0

0

0

D

D D

0

D

D D

0

D

0

D

0

D

D

D

D

D

D D

Reliability
Is the publication easy to read and understand?

Clarity
Are the procedures easy to follow?

Examples
Are they helpful? Are there enough of them?

Organization
Is it easy to locate information?

Graphics
Are they clear and useful?

How did you use this publication?

How did you receive this publication?

D
D

With Equipment/Software
0
Company Representative
Another User
Other_ _ _ _ _ _ _ _ _ _ __

Installation manual
Introduction to the subject
Self-study
Operating instructions
Reference
Training aid
Othcr___________________________________________________________

o
D
o

D

D

D

After reading this publication were you able to use the product? Yes_ _ No_ _
If you noticed errors, please list page number(s)._____________________________
Any comments or suggestions? ________________________________________

Name __________________________ Title_________________________
Company______________________________________________________
Address_________________________________________________________
City___________________________ State/Zip________________________
Phone
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